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Getting started

This section shows you how to install the Easysoft ODBC-FreeAgent Driver and configure the
ODBC data source that stores the connection details for your FreeAgent company. You’re then
ready to work with FreeAgent data in your application.

• Installing the Easysoft ODBC-FreeAgent Driver

• Connecting to FreeAgent

• Working with FreeAgent data

• Logging
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Installing the Easysoft ODBC-FreeAgent Driver

Install the Easysoft ODBC-FreeAgent Driver on the computer where the application you want to
connect to FreeAgent is running.

• Installing on Windows

• Uninstalling on Windows

  7



Installing on Windows

The Windows installation can be done by anyone with local administrator privileges.

1. Download the Easysoft ODBC-FreeAgent Driver installer.
2. Follow the onscreen instructions to progress through the installation wizard.

Updating files that are in use

To avoid rebooting your computer, the Easysoft ODBC-FreeAgent Driver installer prompts you
when files that it needs to update are in use by another application or service. This frees the
locked files and allows the installation to complete without a system restart. The installer uses the
Restart Manager to locate the applications that are using files that need updating. These
applications are displayed in the Files in Use dialog box. To avoid a system restart, choose
Automatically close applications and attempt to restart them after setup is complete. The
Easysoft ODBC-FreeAgent Driver installer then uses Restart Manager to try to stop and restart
each application or service in the list. If possible, Restart Manager restores applications to the
same state that they were in before it shut them down.

Licensing

By default, the installer starts the Easysoft License Manager, because you can’t use the Easysoft
ODBC-FreeAgent Driver until you have a license. If you choose not to run Easysoft License
Manager as part of the installation process, run License Manager from the Easysoft group in the
Windows Start menu when you’re ready to license the Easysoft ODBC-FreeAgent Driver. These
types of license are available:

• A free time-limited trial license, which gives you free and unrestricted use of the product for a
limited period (usually 14 days).

• A full license if you have purchased the product. On purchasing the product you are given an
authorization code, which you use to obtain a license.

To license the Easysoft ODBC-FreeAgent Driver:
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1. In License Manager, enter your contact details.

You must complete the Name, E-Mail Address, and Company fields.

The e-mail address must be the same as the one used to register at the Easysoft web site.
Otherwise, you won’t be able to obtain a trial license.

2. Choose Request License.

You’re prompted to choose a license type.

3. Do one of the following:

- For a trial license, choose Time Limited Trial, and then choose Next. 
-Or-

- For a purchased license, choose Non-expiring License, and then choose Next.
4. Choose your product from the drop-down list when prompted, and then choose Next.
5. For a purchased license, enter your authorization code when prompted, and then choose Next.
6. Choose how to get your license when prompted.
7. Do one of the following:

- Choose On-line Request if your machine is connected to the internet and can make outgoing
connections to port 8884. 
With this method, License Manager automatically requests and then applies your license. 
-Or-

- Choose View Request. Then open a web browser and go to https://www.easysoft.com/
support/licensing/trial_license.html or https://www.easysoft.com/support/licensing/
full_license.html, as appropriate. In the web page, enter your machine number (labelled
Number in the license request). For purchased licenses, you also need to enter your
authorization code (labelled Ref in the license request). 
We’ll automatically email your license to the email address you supplied in License Manager.

-Or-

- Choose Email Request to email your license request to our licensing team. 
Once we’ve processed you request, we’ll email your license to the email address you
supplied in License Manager.

8. Close the License Manager windows and then choose Finish.

If you chose either View Request or Email Request, apply your license by double-clicking the email
attachment when you get the license email from us. Alternatively, start License Manager from the
Easysoft folder in the Windows Start menu. Then choose Enter License and paste the license in
the space provided.

Once you’ve licensed the Easysoft ODBC-FreeAgent Driver, the installation is complete.

Repairing the installation

The installer can repair a broken Easysoft ODBC-FreeAgent Driver installation. For example, you
can use the installer to restore missing Easysoft ODBC-FreeAgent Driver files or registry keys. To
do this:

1. In the Windows Taskbar, enter Add or remove programs in the Windows Search box.
2. Select Easysoft ODBC-FreeAgent Driver in the list, and then choose Repair.
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Uninstalling on Windows

This section explains how to remove the Easysoft ODBC-FreeAgent Driver from your system.

Removing Easysoft ODBC-FreeAgent Driver data sources

Easysoft ODBC-FreeAgent Driver data sources are not removed when you uninstall the Easysoft
ODBC-FreeAgent Driver. You don’t therefore need to recreate your Easysoft ODBC-FreeAgent Driver
data sources if you reinstall or upgrade. If you don’t want to keep your Easysoft ODBC-FreeAgent
Driver data sources, use Microsoft ODBC Data Source Administrator to remove them, before
uninstalling the Easysoft ODBC-FreeAgent Driver:

1. In the Windows Taskbar, enter Run in the Windows Search box.
2. In the Windows Run dialog box, enter:

odbcad32.exe

3. Locate your data source in either the User or System tab.
4. Select the data source from the list, and then choose Remove.

If the Remove button isn’t available, close ODBC Data Source Administrator, and then, in the
Windows Run dialog box, enter:

%windir%\syswow64\odbcad32.exe

Repeat the previous two steps.

Removing the Easysoft ODBC-FreeAgent Driver

1. In the Windows Taskbar, enter Add or remove programs in the Windows Search box.
2. Select Easysoft ODBC-FreeAgent Driver in the list, and then choose Uninstall.

Note
Easysoft product licenses are stored in the Windows registry. When you uninstall, your
licenses are not removed, so you do not need to relicense the product if you reinstall
or upgrade.
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Connecting to FreeAgent

Applications that support ODBC interface with an ODBC Driver Manager, which is included with the
operating system, and also the Easysoft ODBC driver distribution on some platforms. One of the
jobs that the ODBC Driver Manager does is to manage ODBC data sources. A data source specifies
which ODBC driver to load, which data store to connect to, and how to connect to it.

Before setting up a data source, you must have successfully installed the Easysoft ODBC-
FreeAgent Driver.

• Connecting from Windows

Connecting from Windows

Creating an ODBC data source

1. In the Windows Taskbar Search box, enter “Run”.
2. Do one of the following:

- If your application is 64-bit, in the Run dialog box, enter:

odbcad32.exe

-Or-

- If your application is 32-bit, in the Run dialog box, enter:

%windir%\syswow64\odbcad32.exe

Note

If you’re not sure whether your application is 32-bit or 64-bit, start your
application, then in Windows Task Manager check whether your application’s
process name contains (32-bit). For example, the process name for the 32-bit
version of Excel is Microsoft Excel (32-bit); the process name for the 64-bit
version of Excel is Microsoft Excel. On older versions of Windows, 32-bit
applications contain *32 in the process name rather than (32-bit). 
For applications such as Oracle or SQL Server that run as a service, check the
*Background processes* list rather than the Apps list in Task Manager. 
If you’re running a programming language from within a Windows command-line
shell (for example, Command or PowerShell), in your shell, run the .exe file for
the programming language. For example, run perl, php, python, or node. In Task
Manager, expand the process list for Windows Command Processor or
Windows PowerShell, as appropriate, and check whether the process for your
programming language contains (32-bit).

3. Do one of the following:

- To create a data source that only the user you’re currently logged in as can access, choose
the User tab. 
If your application is a Windows service (for example, SQL Server or Oracle) creating a user
data source won’t work, unless the service is running as the same user you’re logged in as.

- To create a data source that all users on this computer can access, choose the System tab.
4. Choose Add.
5. In the list of ODBC drivers, select Easysoft ODBC-FreeAgent Driver, and then choose Finish.
6. Complete the Easysoft ODBC-FreeAgent Driver configuration dialog box. 

To find out how to do this, refer to the Connection attributes section.
7. To test the connection to FreeAgent, choose Test. 
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Note that this doesn’t test that the Easysoft ODBC-FreeAgent Driver is licensed. If you haven’t
yet licensed the Easysoft ODBC-FreeAgent Driver, this ODBC data source won’t work with your
application, even if the Test button succeeds.

Authentication

FreeAgent uses the OAuth security standard to authorise users.

To use the Easysoft ODBC-FreeAgent Driver, you need to obtain a refresh token, which enables the
driver to get the access tokens it needs to make FreeAgent API requests.

By default, the Easysoft ODBC-FreeAgent Driver uses an app that we have registered with
FreeAgent to supply an OAuth client ID and secret. If you want to use your own FreeAgent OAuth
app, specify its client ID and secret in your Easysoft ODBC-FreeAgent Driver data source.

The reasons for using your own OAuth app are:

• You want to replace our text with your own text in the web page that prompts users to grant
access to their FreeAgent data. This page displays when users initially authenticate and obtain
a FreeAgent refresh token. This is done as when configuring an Easysoft ODBC-FreeAgent
Driver data source.

To create an OAuth app:

1. In the FreeAgent Developer Dashboard, choose My Apps.
2. Choose Create New App page, enter a name, description, and home page URL.
3. In the Create a new app page, enter a name.

This name is displayed to users in the web page that prompts them to allow access to their
FreeAgent data.

4. In the OAuth Redirect URIs box, enter http://localhost:port. For example, http://localhost:8090.
5. Choose Create App.

The page that displays next contains the client id (OAuth identifier) and client secret (OAuth
secret) that you need to supply in the Easysoft ODBC-FreeAgent Driver DSN configuration dialog
box.

To obtain a refresh token on Windows, choose the Authenticate and obtain token button in the
configuration dialog box when setting up your data source. This launches your default browser.
Sign into your FreeAgent account and grant the permissions the Easysoft ODBC-FreeAgent Driver
needs when prompted. Close the web browser window or tab when prompted.

You now have a refresh token. The Easysoft ODBC-FreeAgent Driver uses this to request the
access tokens it needs to access your FreeAgent data.
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Connection attributes

Name Value

DSN The name of the data source. You’ll need to
specify this in your application. For example,
your application may prompt you to choose this
from a list of DSNs.

Description Some applications display this to help users
identify a particular data source.

Refresh Token The FreeAgent refresh token that enables the
Easysoft ODBC-FreeAgent Driver to work with
your FreeAgent data.

Local Filtering When turned on, the Easysoft ODBC-FreeAgent
Driver increases its preferred batch size for
queries, which alters the number of FreeAgent
API calls it makes. FreeAgent may create
batches that are larger or smaller than the
requested size to maximise performance.

There is no one correct setting for Local
Filtering, it depends on how your application
executes its queries. You may find that this
attribute increases query performance for one
application and decreases performance for
another.

By default, Local Filtering is turned off.

Proxy If you use a proxy server connect to FreeAgent,
use this attribute to specify this server’s details.
Use this format:

http://address:port

where address is the host name or IP address of
the proxy server and port is the proxy server
port. For example:

http://squid.example.com:8080

Proxy User If your proxy server has authentication turned
on, use this attribute to supply a user name that
can connect to the proxy server.

The Easysoft ODBC-FreeAgent Driver supports
the Basic and Digest proxy authentication
schemes.

Proxy Password The password for the proxy user.
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Name Value

Logging Whether to turn on Easysoft ODBC-FreeAgent
Driver logging. Normally, you’ll only do this if so
directed by the Easysoft support team.

Log File The file name and path of the file you want the
driver to write log information to. For example:

C:\Windows\Temp\Easysoft.log

If the file doesn’t exist, the Easysoft ODBC-
FreeAgent Driver creates it.

Flush On Update Whether the Easysoft ODBC-FreeAgent Driver
flushes its cache when it is used to update or
delete FreeAgent data. When this setting is
turned on, the effect of your changes will apply
in your current session. For example, you turn
on this setting and delete a record. If you then
do a select in the same session, the record will
no longer be present in the result set. If you do
the same with Flush On Update turned off, the
result set contains the deleted record until the
Easysoft ODBC-FreeAgent Driver cache expires
or you reconnect your application (for example,
you restart your SQL Server instance).

Sandbox Turn on this option if you’re connecting to the
FreeAgent sandbox.

Max Num The maximum number of records to return for
each FreeAgent API request the Easysoft ODBC-
FreeAgent Driver makes.
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Name Value

Cache Timeout The time in seconds that Easysoft ODBC-
FreeAgent Driver stores records in its cache. If
you set the timeout to 0, the Easysoft ODBC-
FreeAgent Driver always caches records. The
default value for Cache Timeout is 0.

The Easysoft ODBC-FreeAgent Driver flushes
the cache when you close the connection to
FreeAgent. (For example, you quit your
application or restart your application’s service.)

To reduce FreeAgent API usage and reduce the
amount of data retrieved over the network, the
Easysoft ODBC-FreeAgent Driver caches
FreeAgent records. By default, a record remains
in the cache until the timeout elapses.

Note that any changes to the record that
happen at the FreeAgent end aren’t reflected in
the cached copy until the cache is refreshed
(that is, the timeout expires and the record is
fetched again). If a cached record is changed by
the Easysoft ODBC-FreeAgent Driver, the cache
is refreshed to reflect this change.

Client Id If you have created your own FreeAgent OAuth
or Rest client app, enter the app’s client id here.
Otherwise, leave this field blank.

Client Secret The client secret for your FreeAgent OAuth or
Rest client app.
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DSN-less connections

Some applications allow you to make an ODBC connection without configuring a data source. To
do this, you supply a connection string that contains the ODBC driver name and other driver-
specific attribute-value pairs. Connection string attributes have different names to the ones shown
in the Easysoft ODBC-FreeAgent Driver data source configuration dialog box. Use these attribute
names in a connection string:

• Cache_Timeout

• Description

• Filter_Local

• Flush_On_Update

• Logfile

• Logging

• Max_Num

• Proxy_Pass

• Proxy_User

• Proxy

• Refresh_Token

• Sandbox

Here’s an example connection string for the Windows version of the Easysoft ODBC-FreeAgent
Driver:

Driver={Easysoft FreeAgent ODBC
Driver};Refresh_Token=2000.d2927da21cff612e6818f832a47c256e.379428ee4a4abc3040799df
f191f8620;LogFile=C:\\Temp\\FA.log;

16  DSN-less connections



Working with FreeAgent data

The Easysoft ODBC-FreeAgent Driver lets you use SQL to work with FreeAgent data. Your
application might build the SQL for you or you might have to specify the SQL statements yourself.

SELECT statements

Use either a FreeAgent table or the API view in your queries. For example, both these statements
fetch the comments for a particular bill:

SELECT
    *
FROM
    Bank_Accounts
WHERE
    Id = '1580844'

-Or-

SELECT
  *
FROM
  API
WHERE
  URL = '/v2/bank_accounts/1580844'
  AND Method = 'GET'

Example select queries

SELECT
    *
FROM
    Bills
WHERE
    Status = 'Open'

SELECT
    *
FROM
    Credit_Notes
WHERE
    Status <> 'Refunded'

SELECT
    *
FROM
    Estimates
WHERE
    Estimate_Type = 'Quote'

SELECT
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    *
FROM
    Sales_Tax_Periods
WHERE
    Is_Locked = FALSE

INSERT statements

When inserting a record that has one or more line items, specify the line items with a JSON array.
For example, this line item is for a recurring expense

[
  {
    "item_type": "Days",
    "quantity": "5",
    "price": "1249.99",
    "description": "CON001 : Consultancy"
  },
  {
    "item_type": "Stock",
    "quantity": "7",
    "price": "199.99",
    "description": "WD 1TB 3.5 : Western Digital 1TB 3.5 hard disk drive",
    "stock_item": "https://api.freeagent.com/v2/stock_items/236156"
  }
]

In the INSERT statement, specify the JSON as a single line. For example:

INSERT INTO
    Invoices (
        Contact,
        Dated_On,
        Due_On,
        Currency,
        Exchange_Rate,
        Payment_Terms_In_Days,
        Net_Value,
        Invoice_Items
    )
VALUES
    (
        'https://api.freeagent.com/v2/contacts/18494140',
        '2024-11-27',
        '2024-11-27',
        'USD',
        '0.7263561',
        '30',
        '7649.88',
 
'[{"item_type":"Days","quantity":"5","price":"1249.99","description":"CON001 :
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Consultancy"},{"item_type":"Stock","quantity":"7","price":"199.99","description":"W
D 1TB 3.5 : Western Digital 1TB 3.5 hard disk
drive","stock_item":"https://api.freeagent.com/v2/stock_items/236156"}]'
    )
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Example inserts

• Bill

• Contact

• Credit note

• Estimate

• Expense

• Journal

Bill

Create a new bill:

INSERT INTO
    Bills (Contact, Reference, Dated_On, Due_On, Bill_Items)
VALUES
    (
        'https://api.freeagent.com/v2/contacts/18541472',
        'YEB002',
        '2024-11-28',
        '2024-12-28',
 
'[{"category":"https://api.freeagent.com/v2/categories/291","description":"YEB Line
2 standing charge","sales_tax_rate":"20","total_value_ex_tax":49.99}]'
    )

The JSON for the line items is:

[
  {
    "category": "https://api.freeagent.com/v2/categories/291",
    "description": "YEB Line 2 standing charge",
    "sales_tax_rate": "20",
    "total_value_ex_tax": 49.99
  }
]

Contact

Create a new contact:

INSERT INTO
    Contacts (
        First_Name,
        Last_Name,
        Email,
        Billing_Email,
        Phone_Number,
        Mobile,
        Address1,
        Address2,
        Address3,
        Town,

20  INSERT statements



        Region,
        Postcode,
        Country,
        Uses_Contact_Invoice_Sequence,
        Contact_Name_On_Invoices,
        Charge_Sales_Tax,
        Sales_Tax_Registration_Number,
        [Status],
        Default_Payment_Terms_In_Days,
        Locale
    )
VALUES
    (
        'Thomas, ' Axen ', ' ta@example.com ', ' bills@example.com ', ' (123) 555
-0101 ', ' (321) 555 -0101 ', ' 123 Third Street ', '', '', ' Los Angeles ', ' CA
', ' 99999 ', USA',
        'false',
        'true',
        'Always',
        'US123456789',
        'Active',
        '30',
        'en'
    )
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Credit note

Create a new credit note:

INSERT INTO
    Credit_Notes (Contact, Dated_On, Currency, Credit_Note_Items)
VALUES
    (
        'https://api.freeagent.com/v2/contacts/18494140',
        '2024-11-27',
        'GBP',
        '[{"item_type":"Days","quantity":"1","price":"-
999.99","description":"Consultancy Days"}]'
    )

The JSON for the line items is:

[
  {
    "item_type": "Days",
    "quantity": "1",
    "price": "-999.99",
    "description": "Consultancy Days"
  }
]
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Estimate

Create a new estimate:

INSERT INTO
    Estimates (
        Contact,
        Dated_On,
        [Status],
        Estimate_Type,
        Currency,
        Reference,
        Estimate_Items
    )
VALUES
    (
        'https://api.freeagent.com/v2/contacts/18494140',
        '2024-11-27',
        'Draft',
        'Quote',
        'USD',
        'Customer Ref 2',
 
'[{"item_type":"Days","quantity":"2","price":"999.99","description":"Consultancy
Days"}]'
    )

The JSON for the line items is:

[
  {
    "item_type": "Days",
    "quantity": "2",
    "price": "999.99",
    "description": "Consultancy Days"
  }
]
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Expense

Submit a new expense:

INSERT INTO
    Expenses (
        User,
        Category,
        Dated_On,
        Currency,
        Gross_Value,
        Sales_Tax_Rate,
        Sales_Tax_Status,
        [Description]
    )
VALUES
    (
        'https://api.freeagent.com/v2/users/1861284',
        'https://api.freeagent.com/v2/categories/287',
        '2024-12-03',
        'GBP',
        '-200',
        '20',
        'TAXABLE',
        'Overnight stay'
    )
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Journal

Create a new journal:

INSERT INTO
    Journal_Sets (Dated_On, [Description], Journal_Entries)
VALUES
    (
        '2024-12-03',
        'Sample Journal Created',
 
'[{"category":"https://api.freeagent.com/v2/categories/363","description":"Sample
journal line
1","debit_value":"10"},{"category":"https://api.freeagent.com/v2/categories/001","d
escription":"Sample journal line 2","debit_value":"-10"}]'
    )

The JSON data for the line items is:

[
  {
    "category": "https://api.freeagent.com/v2/categories/363",
    "description": "Sample journal line 1",
    "debit_value": "10"
  },
  {
    "category": "https://api.freeagent.com/v2/categories/001",
    "description": "Sample journal line 2",
    "debit_value": "-10"
  }
]

UPDATE statements

To update records with JSON columns (for example, line items columns), you first need to retrieve
the existing JSON. Then change the existing values, or add new JSON to the existing JSON. For
example:

SELECT Estimate_Items FROM Estimates WHERE Id = '1580844'

returns the following (formatted for readability):

  {
    "item_type": "Days",
    "quantity": "4",
    "price": "999.99",
    "description": "Consultancy Days"
  },
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Add a new line item to the JSON:

  {
    "item_type": "Days",
    "quantity": "4",
    "price": "999.99",
    "description": "Consultancy Days"
  },
  {
    "item_type": "Hours",
    "quantity": "32",
    "price": "172.22",
    "description": "Developer Hours"
  }

and include the revised JSON in an UPDATE statement. Enclose the JSON in square brackets. For
example:

UPDATE Estimates
SET
    Estimate_Items =
'[{"item_type":"Days","quantity":"4","price":"999.99","description":"Consultancy
Days"},{"item_type":"Hours","quantity":"32","price":"172.22","description":"Develop
er Hours"}]'
WHERE
    Id = '5771094'

You can also us the API view to make updates to your FreeAgent data. Use PUT as the method in
your SELECT statement. For example:

SELECT
    *
FROM
    API
WHERE
    Url = '/v2/invoices/default_additional_text'
    AND Method = 'PUT'
    AND RequestBody = '{"default_additional_text":"Please pay promptly."}'

Example updates

• Bank transaction explanation

• Bills

• Contact

• Credit note

• Expense

• Price list

• Users
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Bank transaction explanation

Change the description of a transaction:

UPDATE Bank_Transaction_Explanations
SET
    Description = 'New FEE description text.'
WHERE
    Id = '532804092'

Bills

Update a bill’s comment:

UPDATE Bills
SET
    Comments = 'Standing charge for second line.'
WHERE
    Id = '31467166'

Contact

Update a contact’s contact details:

UPDATE Contacts
SET
    Mobile = '(321)555-0101'
WHERE
    Email = 'ta@example.com'
DELETE FROM Contacts
WHERE
    Id = '18482080'

Credit note

Add credit note line items:

UPDATE Credit_Notes
SET
    Credit_Note_Items = '[{"item_type":"Days","quantity":"4","price":"-
999.99","description":"Consultancy
Days"},{"item_type":"Hours","quantity":"32","price":"-
172.22","description":"Developer Hours"}]'
WHERE
    Id = '73934615'

The JSON data for the line items is:

[
  {
    "item_type": "Days",
    "quantity": "4",
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    "price": "-999.99",
    "description": "Consultancy Days"
  },
  {
    "item_type": "Hours",
    "quantity": "32",
    "price": "-172.22",
    "description": "Developer Hours"
  }
]

Expense

Change the description of an expense:

UPDATE Expenses
SET
    Description = 'Hotel Stay'
WHERE
    Id = '53063365'

Price list

Update a price:

UPDATE Price_List_Items
SET
    Price = 10.99
WHERE
    Code = 'CS001'

Users

Update a name:

UPDATE Users
SET
    Last_Name = 'Jones'
WHERE
    Id = '1853395'

DELETE statements

The Easysoft ODBC-FreeAgent Driver provides two ways to delete records. Either specify a table in
your DELETE statement:

DELETE FROM Bank_Accounts
WHERE
    AccountId = '1558819'

or use the API view instead:
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SELECT
    *
FROM
    API
WHERE
    Url = 'bank_accounts/1558819'
    AND Method = 'DELETE'
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API view

The API view lets you use SQL to make FreeAgent API calls. The view has these columns:

Column Description

URL A FreeAgent API endpoint.

Method GET, PUT, POST, or DELETE.

Code HTTP status code.

Code Description

200 OK

201 Created

400 Bad request

401 Unauthorized
(Invalid AuthToken)

404 Error

405 Method Not Allowed
(Method you have
called is not
supported for the
invoked API)

429 Rate Limit Exceeded
(API usage limit
exceeded)

500 Internal Error

RequestType If NULL, JSON is expected in RequestBody.

RequestBody Data sent to the FreeAgent API.

ResponseType The type of data in the response. For example,
application/json;charset=UTF-8.

ResponseBody Data returned from the FreeAgent API.

Use SELECT statements with the API view. To select data set Method to GET. To insert data set
Method to POST. To insert data set Method to PUT. To delete data set Method to DELETE.

Use a WHERE clause to specify the URL, Method, and, if updating or inserting data, RequestBody.
For example:

30  API view



-- Fetch the additional text for an invoice
SELECT
    *
FROM
    API
WHERE
    Url = '/v2/invoices/default_additional_text'
    AND Method = 'GET'

-- Remove a bank account
SELECT
    *
FROM
    API
WHERE
    Url = 'bank_accounts/1558819'
    AND Method = 'DELETE'

-- Add a bank transaction
SELECT
    *
FROM
    API
WHERE
    Url = '/v2/bank_transactions/statement?bank_account=1555435'
    AND Method = 'POST'
    AND RequestBody = '[{"statement":[{"dated_on":"2024-11-
26","description":"CREDIT line test","amount":"298","fitid":"031AE5B1-FC68-4889-
935E-327897E31B67","transaction_type":"CREDIT"},{"dated_on":"2024-11-
26","description":"DEBIT line test","amount":"130","fitid":"93845D69-7CB3-491E-
B16B-2D186F0A0241","transaction_type":"DEBIT"}]}]'

-- Update an invoice status
SELECT
    *
FROM
    API
WHERE
    Url = '/v2/invoices/73959649/transitions/mark_as_sent'
    AND Method = 'PUT'

For more information, consult the FreeAgent API documentation.

JSON columns

Columns that can contain multiple values are in JSON format. For example, a bill’s line items (Bill
table’s Line_Items column):

To update records with JSON columns (for example, line items columns), you first need to retrieve
the existing JSON. Then change the existing values, or add new JSON to the existing JSON. For
example:
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SELECT Estimate_Items FROM Estimates WHERE Id = '1580844'

returns the following (formatted for readability):

{
  "item_type": "Days",
  "quantity": "4",
  "price": "999.99",
  "description": "Consultancy Days"
},

Add a new line item to the JSON:

{
  "item_type": "Days",
  "quantity": "4",
  "price": "-999.99",
  "description": "Consultancy Days"
},
{
  "item_type": "Hours",
  "quantity": "32",
  "price": "-172.22",
  "description": "Developer Hours"
}

and include the revised JSON in an UPDATE statement. Enclose the JSON in square brackets. For
example:

UPDATE Credit_Note_Items
SET
    Estimate_Items = '[{"item_type":"Days","quantity":"4","price":"-
999.99","description":"Consultancy
Days"},{"item_type":"Hours","quantity":"32","price":"-
172.22","description":"Developer Hours"}]'
WHERE
    Id = '1580844'

In the FreeAgent API, JSON has this format:

• Data is in name/value pairs.

• Data is separated by commas.

• Curly braces ({}) hold objects.

• Square brackets ([]) hold arrays.

All the data names in the FreeAgent API are in lower case. JSON is case sensitive.

In the API we connect to, JSON values must be one of the following data types:

• Array

• Boolean

• Date

• Datetime

• Decimal
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• Object

• String

• Timestamp

• URI

In some of the JSON returned, you may get something like:

"tags":[]

This denotes an empty array.
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String data needs to be escaped:

• Backslash becomes \\

• Backspace becomes \b

• Form feed becomes \f

• Newline becomes \n

• Carriage return becomes \r

• Tab becomes \t

• Double quote becomes \"
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Logging

If you report an issue to us, we may ask you to turn on ODBC Driver Manager or Easysoft ODBC-
FreeAgent Driver logging, to help us diagnose the cause of the issue.

To turn on logging, refer to the following sections.

Note

If your application is a service (for example, Oracle or SQL Server), you may need to
restart the service before enabling logging takes effect. To do this on Linux or UNIX,
use service, systemctl, or a vendor-supplied script. To do this on Windows, use the
Windows Services app.

ODBC Driver Manager logging on Windows

1. In the Windows Taskbar Search box, enter “Run”.
2. Do one of the following:

- If your application is 64-bit, in the Run dialog box, enter:

odbcad32.exe

-Or-

- If your application is 32-bit, in the Run dialog box, enter:

%windir%\syswow64\odbcad32.exe

Note

If you’re not sure whether your application is 32-bit or 64-bit, start your
application, then in Windows Task Manager check whether your application’s
process name contains (32-bit). For example, the process name for the 32-bit
version of Excel is Microsoft Excel (32-bit); the process name for the 64-bit
version of Excel is Microsoft Excel. On older versions of Windows, 32-bit
applications contain *32 in the process name rather than (32-bit). 
For applications such as Oracle or SQL Server that run as a service, check the
*Background processes* list rather than the Apps list in Task Manager. 
If you’re running a programming language from within a Windows command-line
shell (for example, Command or PowerShell), in your shell, run the .exe file for
the programming language. For example, run perl, php, python, or node. In Task
Manager, expand the process list for Windows Command Processor or
Windows PowerShell, as appropriate, and check whether the process for your
programming language contains (32-bit).

3. Choose the Tracing tab.
4. Select Machine-Wide tracing for all identities.
5. Enter a log file name and path in the space provided. For example:

C:\Windows\Temp\SQL.log

6. Choose Start Tracing Now.
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Note

With SQL Server, you may get two Driver Manager log files, we need both. The first log
file is in the folder that you specify in ODBC Data Source Administrator. The second
file’s location is defined by SQL Server. Two possible locations are the top-level folder
(for example, C:\SQL.log) or the SQL Server temporary folder (for example,
C:\Users\MSSQL$SQLEXPRESS\AppData\Local\Temp\SQL.log). If the Driver
Manager log file isn’t in these folders, search for it on the drive where SQL Server is
installed.

Easysoft ODBC-FreeAgent Driver logging on Windows

1. In the Windows Taskbar Search box, enter “Run”.
2. Do one of the following:

- If your application is 64-bit, in the Run dialog box, enter:

odbcad32.exe

-Or-

- If your application is 32-bit, in the Run dialog box, enter:

%windir%\syswow64\odbcad32.exe

Note

If you’re not sure whether your application is 32-bit or 64-bit, start your
application, then in Windows Task Manager check whether your application’s
process name contains (32-bit). For example, the process name for the 32-bit
version of Excel is Microsoft Excel (32-bit); the process name for the 64-bit
version of Excel is Microsoft Excel. On older versions of Windows, 32-bit
applications contain *32 in the process name rather than (32-bit). 
For applications such as Oracle or SQL Server that run as a service, check the
*Background processes* list rather than the Apps list in Task Manager. 
If you’re running a programming language from within a Windows command-line
shell (for example, Command or PowerShell), in your shell, run the .exe file for
the programming language. For example, run perl, php, python, or node. In Task
Manager, expand the process list for Windows Command Processor or
Windows PowerShell, as appropriate, and check whether the process for your
programming language contains (32-bit).

3. Do one of the following:

- If you configured a system data source, choose the System DSN tab. 
-Or-

- If you configured a system data source, choose the System DSN tab.
4. Choose your Easysoft ODBC-FreeAgent Driver data source from the list, and then choose

Configure.
5. In the Easysoft ODBC-FreeAgent Driver data source configuration dialog box, turn on Driver

Logging.
6. Enter a log file name and path in the space provided. For example:

C:\Windows\Temp\Easysoft.log
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Finding out what product version you have on Windows

If you have an issue with the Easysoft ODBC-FreeAgent Driver, we may ask you to tell us what your
product version is. To find this out:

1. In the Windows Taskbar, enter “Add or remove programs” in the Windows Search box.
2. Select Easysoft ODBC-FreeAgent Driver in the list.

The product version displays below.
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Client applications

How to work with FreeAgent data in some example applications and programming languages:

• Microsoft Access

• Microsoft Excel

• Microsoft Power BI

• SQL Server

• Oracle

• LibreOffice

• Go

• Node.js

• Perl

• PHP

• Python

• R
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Microsoft Access

1. Install the Easysoft ODBC-FreeAgent Driver on same computer as Access.
2. Configure an ODBC data source.
3. Choose one of the following ways to work with your FreeAgent data in Access.

Linking a table

1. Open your Microsoft Access database.
2. Choose External Data.
3. In the New Data Source list, choose From Other Sources > ODBC Database.
4. In the Get External Data screen, choose Link to the data source by creating a linked table, and

choose OK.
5. In the Select Data Source dialog box, choose the Machine Data Source tab.
6. Choose your Easysoft ODBC-FreeAgent Driver ODBC data source from the Machine Data

Source list, and then choose OK.
7. In the Link Tables dialog box, choose the tables that you want to link to, and then choose OK.

Importing a table

1. Open your Microsoft Access database.
2. Choose External Data.
3. In the New Data Source list, choose From Other Sources > ODBC Database.
4. In the Get External Data screen, choose Import the source data into a new table in the current

database, and choose OK.
5. In the Select Data Source dialog box, choose the Machine Data Source tab.
6. Choose your Easysoft ODBC-FreeAgent Driver ODBC data source from the Machine Data

Source list, and then choose OK.
7. In the Import Objects dialog box, choose the tables you want to import, and then choose OK.
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Microsoft Excel

1. Install the Easysoft ODBC-FreeAgent Driver on same computer as Excel.
2. Configure an ODBC data source.
3. Choose one of the following ways to work with your FreeAgent data in Excel.

Data Connection Wizard

1. Choose Data > Get Data > From Other Sources > From ODBC.
2. Choose your Easysoft ODBC-FreeAgent Driver data source from the list, and then choose OK.
3. Enter the user name and password for your data store if applicable, otherwise, enter any text

string to get past this stage. Choose Next.
4. Choose the table that contains the data you want to retrieve, and then choose Load.

Microsoft Query

1. Choose Data > Get Data > From Other Sources > From Microsoft Query.
2. In the Choose Data Source dialog box, choose your FreeAgent data source from the list, and

then choose OK.
3. In the Query Wizard, choose the columns that contain the data you want to retrieve, and then

click Next.
4. If you want to return a subset of the data, use the Filter Data screen to filter the results of your

query (this is the equivalent of a SQL WHERE clause), and then choose Next.
5. If you want to change the sort order of your data, use the Sort Order screen to sort the results

of your query (this is the equivalent of a SQL ORDER BY clause), and then choose Next. Choose
Finish to return your FreeAgent data to Excel.

PowerPivot

1. On the PowerPivot tab, choose Manage.
2. In the PowerPivot window, choose Get External Data > From Other Sources.
3. In the Connect to a Data Source list, choose Others (OLEDB/ODBC)
4. In the Specify a Connection screen, enter a name for your connection in the space provided.

Then choose Build.
5. In the Data Link Properties box, choose your Easysoft ODBC-FreeAgent Driver data source from

the list, and then choose OK.
6. Choose Next.
7. Choose how to import your FreeAgent data and then choose Finish.
8. Choose Close to return the data to Excel.
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Microsoft Power BI

1. Install the Easysoft ODBC-FreeAgent Driver on same computer as Power BI Desktop.
2. Configure an ODBC data source.
3. In Power BI Desktop, choose Get data from another source.
4. In the Get Data dialog box, choose ODBC, and then choose Connect.
5. In the From ODBC dialog box, choose your FreeAgent data source, and then choose OK.
6. Enter your database user name and password when prompted.

If you make a mistake when entering the user name and password, cancel the connection
process. Then in Power BI Desktop Options and Settings, edit the data source. Specify the
correct user name or password in the data source credentials dialog box. Otherwise, Power BI
Desktop will continue to use the cached incorrect credentials.

Note
If you do not normally need to enter a user name and password, enter some
dummy strings in the spaces provided.

7. In the Navigator dialog box, choose the tables you want to analyse in Power BI Desktop, and
then choose Load.

Your FreeAgent data is now available to use in Power BI visualisations.
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Microsoft SQL Server

1. Install the Easysoft ODBC-FreeAgent Driver on same computer as SQL Server.
2. Configure an ODBC data source.
3. In Microsoft SQL Server Management Studio, connect to the SQL Server instance you want to

create the linked server against.

You need to log on with an account that is a member of the SQL Server sysadmin fixed server
role to create a linked server.

4. Right-click Server Objects. From the pop-up menu choose New > Linked Server.
5. In the Linked server box, enter "FreeAgent".
6. From the Provider list, choose Microsoft OLE DB Provider for ODBC drivers.
7. In the Data source box, enter the name of your FreeAgent data source, and then choose OK.

SQL Server verifies the linked server by testing the connection.

- If you get the error "Specified driver could not be loaded due to system error 126: The
specified module could not be found," choose Yes when prompted whether to keep the
linked server. You need to restart your SQL Server instance before you can use the linked
server. If SQL Server was already running when you installed the Easysoft ODBC-FreeAgent
Driver, it will not have the latest version of the System Path environment variable. The
Easysoft ODBC-FreeAgent Driver Setup program adds entries for the driver to the System
Path. Restarting the instance makes these changes available to SQL Server, allowing it to
load the Easysoft ODBC-FreeAgent Driver.

- If you made a mistake when specifying the Easysoft ODBC-FreeAgent Driver, you get the
error "Data source name not found and no default driver specified." If you get this error,
choose No when prompted whether to keep the linked server and edit the value in the Data
source box.

8. You can query your Easysoft ODBC-FreeAgent Driver data either by using a:

- Four part table name in a distributed query.

A four part table name has the format:

server_name.[database_name].[schema_name].table_name

For data stores where there is no database or schema, Easysoft ODBC drivers return a
"dummy" value for both identifiers, because some ODBC applications expect there to be a
database and a schema. To find out the identifier names, run:

EXEC sp_tables_ex @table_server = 'FreeAgent'

If present, include these identifiers in your SQL statements. If not present, omit them. For
example:

SELECT * FROM [FreeAgent].FREEAGENT.DBO.Bills

The capitalisation of the table name must be the same as it is in the result set returned by
sp_tables_ex.

- Pass-through query in an OPENQUERY function. For example:

SELECT * FROM OPENQUERY([FreeAgent], 'SELECT * FROM Bills')

-- If you get an "RPC not enabled for this server" message, right-click your
linked server and choose Properties.
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-- In Server Options, set both RPC and RPC Out to `True`.
EXEC ('INSERT INTO Bills (Contact, Reference, Dated_On, Due_On, Bill_Items)
VALUES (''https://api.freeagent.com/v2/contacts/18727314'' , ''YEB021'' ,
''2025-01-16'' , ''2025-01-16'' ,
''[{\"category\":\"https://api.freeagent.com/v2/categories/291\",\"description
\":\"YEB-line-2-standing-
charge\",\"sales_tax_rate\":\"20\",\"total_value_ex_tax\":6.99}]'')')
AT FreeAgent

UPDATE OPENQUERY ([FreeAgent], 'SELECT Contact FROM Bills WHERE Id =
''31962267''') SET Contact='Standing charges for second line.'
DELETE OPENQUERY (FreeAgent, 'SELECT Contact FROM Bills WHERE Id =
''31962267''')

SQL Server sends pass-through queries as uninterpreted query strings to the FreeAgent. This
means that SQL Server does not apply any kind of logic to the query or try to estimate what
that query will do.
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Oracle

1. Install the Easysoft ODBC-FreeAgent Driver on same computer as Oracle.
2. Configure an ODBC data source.
3. Follow the instructions for your Oracle platform.

Connecting FreeAgent to Oracle on Windows

1. Create a DG4ODBC init file on your Oracle machine. To do this, change to the
%ORACLE_HOME%\hs\admin directory. Create a copy of the file initdg4odbc.ora. Name the
new file initFreeAgent.ora.

Note
In these instructions, replace %ORACLE_HOME% with the location of your Oracle
HOME directory. For example, C:\app\product\21c\homes\OraDB21Home1.

2. Ensure these parameters and values are present in your init file:

HS_FDS_CONNECT_INFO = "FreeAgent"

Replace FreeAgent with the name of your Easysoft ODBC-FreeAgent Driver data source.

3. Comment out the line that enables DG4ODBC tracing. For example:

#HS_FDS_TRACE_LEVEL = <trace_level>

4. Add an entry to %ORACLE_HOME%\network\admin\listener.ora that creates a SID_NAME for
DG4ODBC. For example:

SID_LIST_LISTENER =
 (SID_LIST =
   (SID_DESC=
     (SID_NAME=FreeAgent)
     (ORACLE_HOME=%ORACLE_HOME%)
     (PROGRAM=dg4odbc)
   )
 )

5. Add a DG4ODBC entry to %ORACLE_HOME%\network\admin\tnsnames.ora that specifies the
SID_NAME created in the previous step. For example:

FreeAgent =
  (DESCRIPTION =
    (ADDRESS = (PROTOCOL = TCP)(HOST = oracle_host)(PORT = 1521))
    (CONNECT_DATA =
      (SID = FreeAgent)
    )
    (HS = OK)
  )

Replace oracle_host with the host name of your Oracle machine.

6. Start (or restart) the Oracle Listener:

cd %ORACLE_HOME%\bin
lsnrctl stop

44  Connecting FreeAgent to Oracle on Windows



lsnrctl start

7. Connect to your Oracle database in SQL*Plus.
8. In SQL*Plus, create a database link for FreeAgent. For example:

CREATE PUBLIC DATABASE LINK FreeAgentLink
    CONNECT TO "dbuser" IDENTIFIED BY "dbpassword"
    USING 'FreeAgent';

Replace dbuser and dbpassword with your backend user name and password, if applicable.

9. Try querying and updating your FreeAgent data. For example:

SELECT "Contact" FROM "Bills"@FreeAgentLink;

DECLARE
  num_rows integer;
BEGIN
num_rows:=DBMS_HS_PASSTHROUGH.EXECUTE_IMMEDIATE@FreeAgentLink
('INSERT INTO Bills (Contact, Reference, Dated_On, Due_On, Bill_Items) VALUES
(''https://api.freeagent.com/v2/contacts/18727314'', ''YEB021'', ''2025-01-16'',
''2025-01-16'',
''[{\"category\":\"https://api.freeagent.com/v2/categories/291\",\"description\":
\"YEB-line-2-standing-
charge\",\"sales_tax_rate\":\"20\",\"total_value_ex_tax\":6.99}]'')');
END;
/

DECLARE
  num_rows integer;
BEGIN
num_rows:=DBMS_HS_PASSTHROUGH.EXECUTE_IMMEDIATE@FreeAgentLink
('UPDATE "Bills" SET "Contact" = ''Standing charges for second line.'' WHERE "Id"
= ''31962267''');
END;
/

DECLARE
  num_rows integer;
BEGIN
num_rows:=DBMS_HS_PASSTHROUGH.EXECUTE_IMMEDIATE@FreeAgentLink
('DELETE from "Bills" WHERE Id = ''31962267''');
END;
/

Notes

• If you have problems connecting to FreeAgent from Oracle, enable DG4ODBC tracing and check
the trace files written to the %ORACLE_HOME%\hs\trace directory. To enable DG4ODBC tracing,
add the line HS_FDS_TRACE_LEVEL = DEBUG to initFreeAgent.ora and then start or restart the
Oracle listener. If the trace directory does not exist, create it.

• If you enable ODBC Driver Manager tracing, but do not get a log file in the location you specify,
try looking in the top-level folder (for example, C:\SQL.log). Alternatively, in ODBC Data Source
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Administrator, change the trace file location to the Windows TEMP directory.

Connecting FreeAgent to Oracle on Linux and UNIX

1. Create a DG4ODBC init file on your Oracle machine. To do this, change to the
$ORACLE_HOME\hs\admin directory. Create a copy of the file initdg4odbc.ora. Name the new
file initFreeAgent.ora.

Note
In these instructions, replace $ORACLE_HOME with the location of your Oracle
HOME directory. For example, /u01/app/oracle/product/21c/dbhome_1.

2. Ensure these parameters and values are present in your init file:

HS_FDS_CONNECT_INFO = "FreeAgent"

Replace FreeAgent with the name of your Easysoft ODBC-FreeAgent Driver data source.

3. Comment out the line that enables DG4ODBC tracing. For example:

#HS_FDS_TRACE_LEVEL = <trace_level>

4. Add an entry to $ORACLE_HOME/network/admin/listener.ora that creates a SID_NAME for
DG4ODBC. For example:

SID_LIST_LISTENER =
 (SID_LIST =
   (SID_DESC=
     (SID_NAME=FreeAgent)
     (ORACLE_HOME=$ORACLE_HOME)
     (PROGRAM=dg4odbc)
     (ENVS=LD_LIBRARY_PATH = /usr/local/easysoft/unixODBC/lib:
            /usr/local/easysoft/lib)
   )
 )

Replace oracle_home_directory with the value of $ORACLE_HOME. For example,
/u01/app/oracle/product/21c/dbhome_1.

5. Add a DG4ODBC entry to $ORACLE_HOME/network/admin/tnsnames.ora that specifies the
SID_NAME created in the previous step. For example:

FreeAgent =
  (DESCRIPTION =
    (ADDRESS = (PROTOCOL = TCP)(HOST = oracle_host)(PORT = 1521))
    (CONNECT_DATA =
      (SID = FreeAgent)
    )
    (HS = OK)
  )

Replace oracle_host with the host name of your Oracle machine.

6. Start (or restart) the Oracle Listener:

cd $ORACLE_HOME/bin
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./lsnrctl stop

./lsnrctl start

7. Connect to your Oracle database in SQL*Plus.
8. In SQL*Plus, create a database link for FreeAgent. For example:

CREATE PUBLIC DATABASE LINK FreeAgentLink
    CONNECT TO "dbuser" IDENTIFIED BY "dbpassword"
    USING 'FreeAgent';

Replace dbuser and dbpassword with your backend user name and password, if applicable.

9. Try querying and updating your FreeAgent data. For example:

SELECT "Contact" FROM "Bills"@FreeAgentLink;

DECLARE
  num_rows integer;
BEGIN
num_rows:=DBMS_HS_PASSTHROUGH.EXECUTE_IMMEDIATE@FreeAgentLink
('INSERT INTO Bills (Contact, Reference, Dated_On, Due_On, Bill_Items) VALUES
(''https://api.freeagent.com/v2/contacts/18727314'', ''YEB021'', ''2025-01-16'',
''2025-01-16'',
''[{\"category\":\"https://api.freeagent.com/v2/categories/291\",\"description\":
\"YEB-line-2-standing-
charge\",\"sales_tax_rate\":\"20\",\"total_value_ex_tax\":6.99}]'')');
END;
/

DECLARE
  num_rows integer;
BEGIN
num_rows:=DBMS_HS_PASSTHROUGH.EXECUTE_IMMEDIATE@FreeAgentLink
('UPDATE "Bills" SET "Contact" = ''Standing charges for second line.'' WHERE "Id"
= ''31962267''');
END;
/

DECLARE
  num_rows integer;
BEGIN
num_rows:=DBMS_HS_PASSTHROUGH.EXECUTE_IMMEDIATE@FreeAgentLink
('DELETE from "Bills" WHERE Id = ''31962267''');
END;
/

Notes

• If you have problems connecting to FreeAgent from Oracle, enable DG4ODBC tracing and check
the trace files written to the $ORACLE_HOME/hs/trace directory. To enable DG4ODBC tracing,
add the line HS_FDS_TRACE_LEVEL = DEBUG to initFreeAgent.ora and then start or restart the
Oracle listener. If the trace directory does not exist, create it.
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LibreOffice

1. Install the Easysoft ODBC-FreeAgent Driver on same computer as LibreOffice.
2. Configure an ODBC data source.
3. Choose File > New > Database.
4. Choose Connect to an existing database.
5. Choose ODBC in the list, and then choose Next.
6. Choose Browse, double-click your data source, and then choose Next.
7. If your database requires a database user name, enter it in the User name box. If this user

needs to supply a password choose the Password required check box.
8. Choose Finish.
9. Save the database when prompted.

The database opens in a new Base window. From here you can access your data.

10. In the left pane of the database window, choose the Tables icon to display a hierarchy of tables.
Enter the database password if prompted, and then choose OK.

11. To retrieve the data in a table, in the Tables pane, double-click a table.
12. Choose the Queries icon to create a query.

Use any of the methods listed in the Tasks pane to create a query.
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Go

1. Install the Easysoft ODBC-FreeAgent Driver on same computer as Go.
2. Configure an ODBC data source.
3. Install the odbc package for Go:

go mod init test
go get github.com/alexbrainman/odbc

4. Create and then use Go to run this script, which retrieves some FreeAgent data:

package main

import (
    _ "github.com/alexbrainman/odbc"
    "database/sql"
        "log"
)

func main() {
        // Replace the DSN value with the name of your ODBC data source.
        db, err := sql.Open("odbc",
                "DSN=FreeAgent")
        if err != nil {
                log.Fatal(err)
        }

        var (
                name string
        )

        rows, err := db.Query("SELECT Contact FROM Bills")
        if err != nil {
                log.Fatal(err)
        }
        defer rows.Close()
        for rows.Next() {
                err := rows.Scan(&name)
                if err != nil {
                        log.Fatal(err)
                }
                log.Println(name)
        }
        err = rows.Err()
        if err != nil {
                log.Fatal(err)
        }

        defer db.Close()
}
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Node.js

1. Install the Easysoft ODBC-FreeAgent Driver on same computer as Node.js.
2. Configure an ODBC data source.
3. Install the odbc module for Node.js:

npm install odbc

4. Create and then use Node.js to run this script, which retrieves some FreeAgent data:

const odbc = require('odbc');
// Replace FreeAgent with the name of your Easysoft ODBC-FreeAgent Driver
// data source.
const connection = odbc.connect('DSN=FreeAgent', (error, connection) => {
    connection.query('SELECT Contact FROM Bills', (error, result) => {
        if (error) { console.error(error) }
        console.log(result);
    });
});

5. This script retrieves the tables and views in your Easysoft ODBC-FreeAgent Driver data source:

const odbc = require('odbc');
const connection = odbc.connect('DSN=FreeAgent', (error, connection) => {
    connection.tables(null, null, null, null, (error, result) => {
        if (error) { return; }
        const util = require('util');
        console.log(util.inspect(result, {maxArrayLength: null, depth:null}))
    });
});

6. This script retrieves the names of the columns in these tables and views:

const odbc = require('odbc');
const connection = odbc.connect('DSN=FreeAgent', (error, connection) => {
    connection.columns(null, null, null, null, (error, result) => {
        if (error) { return; }
        const util = require('util');
        console.log(util.inspect(result, {maxArrayLength: null, depth:null}))
    });
});

7. These scripts insert, update, and then delete some FreeAgent data:

const odbc = require("odbc");
const connection = odbc.connect("DSN=FreeAgent", (error, connection) => {
    connection.query("INSERT INTO
    Bills (
        Contact,
        Reference,
        Dated_On,
        Due_On,
        Bill_Items
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    )
VALUES
    (
        'https://api.freeagent.com/v2/contacts/18727314',
        'YEB021',
        '2025-01-16',
        '2025-01-16',
 
'[{\"category\":\"https://api.freeagent.com/v2/categories/291\",\"description\":\
"YEB-line-2-standing-
charge\",\"sales_tax_rate\":\"20\",\"total_value_ex_tax\":6.99}]'
    )", (error, result) => {
        if (error) { console.error(error) }
        console.log(result);
    });
});

const odbc = require("odbc");
const connection = odbc.connect("DSN=FreeAgent", (error, connection) => {
    connection.query("UPDATE Bills SET Contact = 'Standing charges for second
line.' WHERE Id = '31962267'", (error, result) => {
        if (error) { console.error(error) }
        console.log(result);
    });
});

const odbc = require("odbc");
const connection = odbc.connect("DSN=FreeAgent", (error, connection) => {
    connection.query("DELETE FROM Bills WHERE Id = '31962267'", (error, result)
=> {
        if (error) { console.error(error) }
        console.log(result);
    });
});
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Perl

1. Install the Easysoft ODBC-FreeAgent Driver on same computer as Perl.
2. Configure an ODBC data source.
3. Check whether your Perl distribution supports ODBC:

perl -e 'use DBD::ODBC;'

4. Do one of the following:

- If you get no output, your Perl distribution supports ODBC. Skip to the next step.

- If you get:

Can't locate DBD/ODBC.pm

you need to install DBD::ODBC before you can use the Easysoft ODBC-FreeAgent Driver to
connect to FreeAgent.

5. Create and then use Perl to run this script, which retrieves some FreeAgent data:

use strict;
use DBI;
# Replace FreeAgent with the name of your Easysoft ODBC-FreeAgent Driver data
source.
my $dbh = DBI-> connect('dbi:ODBC:FreeAgent');

my $sql = "SELECT Contact FROM Bills";

my $sth = $dbh->prepare($sql)
    or die "Can't prepare statement: $DBI::errstr";

$sth->execute();

my($Col);

# Fetch and display the result set values.
while(($Col) = $sth->fetchrow()){
   print("$Col\n");
}

$dbh->disconnect if ($dbh);

6. This script retrieves the tables and views in your Easysoft ODBC-FreeAgent Driver data source:

use strict;
use DBI;
my $dbh = DBI-> connect('dbi:ODBC:FreeAgent');

my $sth = $dbh->table_info()
    or die "Can't prepare statement: $DBI::errstr";

my @row;

while (@row = $sth->fetchrow_array) {
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    print join(", ", @row), "\n";
}

$dbh->disconnect if ($dbh);

7. This script retrieves the names of the columns in these tables and views:

use strict;
use DBI;
my $dbh = DBI-> connect('dbi:ODBC:FreeAgent');

my $sth = $dbh->column_info('','','','')
    or die "Can't prepare statement: $DBI::errstr";

my @row;
while (@row = $sth->fetchrow_array) {
    print join(", ", @row), "\n";
}

$dbh->disconnect if ($dbh);

8. These scripts insert, update, and then delete some FreeAgent data:

use strict;
use DBI;
my $dbh = DBI-> connect('dbi:ODBC:FreeAgent');

my $sth = $dbh->prepare(q/INSERT INTO Bills (Contact, Reference, Dated_On,
Due_On, Bill_Items) VALUES (?, ?, ?, ?, ?)/)
    or die "Can't prepare statement: $DBI::errstr";

$sth->execute('https://api.freeagent.com/v2/contacts/18727314', 'YEB021', '2025-
01-16', '2025-01-16',
'[{\"category\":\"https://api.freeagent.com/v2/categories/291\",\"description\":\
"YEB-line-2-standing-
charge\",\"sales_tax_rate\":\"20\",\"total_value_ex_tax\":6.99}]');

$dbh->disconnect if ($dbh);

use strict;
use DBI;
my $dbh = DBI-> connect('dbi:ODBC:FreeAgent');

my $sth = $dbh->prepare('UPDATE Bills SET Contact = \'Standing charges for second
line.\' WHERE Id = ?')
    or die "Can't prepare statement: $DBI::errstr";

$sth->execute('31962267');

$dbh->disconnect if ($dbh);

use strict;
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use DBI;
my $dbh = DBI-> connect('dbi:ODBC:FreeAgent');

my $sth = $dbh->prepare('DELETE FROM Bills WHERE Id = ?')
    or die "Can't prepare statement: $DBI::errstr";

$sth->execute('31962267');

$dbh->disconnect if ($dbh);

Further information

• Perl DBI DBD::ODBC tutorial: Drivers, data sources, and connection
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PHP

1. Install the Easysoft ODBC-FreeAgent Driver on same computer as PHP.
2. Configure an ODBC data source.
3. Check whether your PHP distribution supports ODBC. In php.ini, make sure there is no comment

character (;) before the extension_dir and extension=odbc settings (;extension_dir=directory
becomes extension_dir=directory and ;extension=odbc becomes extension=odbc).

4. Create and then use PHP to run this script, which retrieves some FreeAgent data:

<?php
  // Replace FreeAgent with the name of your Easysoft ODBC-FreeAgent Driver data
source.
  //  If your database requires a user name and password, supply them in the
odbc_connect_call.
  $con = odbc_connect("FreeAgent", "", "");
  $stmt = odbc_exec($con, "SELECT * FROM Bills");
  // You may need to change the capitalisation of Contact to all upper case or
all lower case.
  while ($row = odbc_fetch_array($stmt)) {
      echo "Contact = ", $row["Contact"], "\n";
  }
  odbc_close($con);
?>

5. This script retrieves the tables and views in your Easysoft ODBC-FreeAgent Driver data source:

<?php
$con = odbc_connect("FreeAgent", "", "");
$tables = odbc_tables($con);
while (($row = odbc_fetch_array($tables))) {
    print_r($row);
}
odbc_close($con);
?>

6. This script retrieves the names of the columns in these tables and views:

<?php
$con = odbc_connect("FreeAgent", "", "");
$columns = odbc_columns($con);
while (($row = odbc_fetch_array($columns))) {
    print_r($row);
}
odbc_close($con);
?>

7. These scripts insert, update, and then delete some FreeAgent data:

<?php
  $cnx = odbc_connect("FreeAgent", "", "");
  $stmt = odbc_prepare($cnx, "INSERT INTO Bills (Contact, Reference, Dated_On,
Due_On, Bill_Items) VALUES (?, ?, ?, ?, ?)");
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  $success = odbc_execute($stmt,
array('https://api.freeagent.com/v2/contacts/18727314', 'YEB021', '2025-01-16',
'2025-01-16',
'[{\"category\":\"https://api.freeagent.com/v2/categories/291\",\"description\":\
"YEB-line-2-standing-
charge\",\"sales_tax_rate\":\"20\",\"total_value_ex_tax\":6.99}]'));
  odbc_close($cnx);
?>

<?php
  $cnx = odbc_connect("FreeAgent", "", "");
  $stmt = odbc_prepare($cnx, "UPDATE Bills SET Contact = 'Standing charges for
second line.' WHERE Id = ?");
  $success = odbc_execute($stmt, array('31962267'));
  odbc_close($cnx);
?>

<?php
  $cnx = odbc_connect("FreeAgent", "", "");
  $stmt = odbc_prepare($cnx, "DELETE FROM Bills WHERE Id = ?");
  $success = odbc_execute($stmt, array('31962267'));
  odbc_close($cnx);
?>

Further information

• Easysoft PHP tutorials and code samples
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Python

1. Install the Easysoft ODBC-FreeAgent Driver on same computer as Python.
2. Configure an ODBC data source.
3. Check whether your Python distribution supports ODBC.

pip list

If you don’t have pip installed:

curl https://bootstrap.pypa.io/get-pip.py -o get-pip.py
python get-pip.py

4. Do one of the following:

- If the output contains pyodbc, your Python distribution supports ODBC. Skip to the next step.

- If the output does not contain pyodbc, use pip to install this module:

pip install pyodbc

5. Create and then use Python to run this script, which retrieves some FreeAgent data:

import pyodbc

# Replace FreeAgent with the name of your Easysoft ODBC-FreeAgent Driver data
source.
cnxn = pyodbc.connect("DSN=FreeAgent")
cursor = cnxn.cursor()
sql = "SELECT Contact FROM Bills"
cursor.execute(sql)
rows = cursor.fetchall()
# You may need to change the capitalisation of Contact to all upper case or all
lower case.
for row in rows:
     print(row.Contact)
exit()

6. This script retrieves the tables and views in your Easysoft ODBC-FreeAgent Driver data source:

import pyodbc

# Replace FreeAgent with the name of your Easysoft ODBC-FreeAgent Driver data
source.
cnxn = pyodbc.connect("DSN=FreeAgent")
cursor = cnxn.cursor()
cursor.tables()
rows = cursor.fetchall()
for row in rows:
     print(row.table_name)
exit()

7. This script retrieves the names of the columns in these tables and views:

import pyodbc
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# Replace FreeAgent with the name of your Easysoft ODBC-FreeAgent Driver data
source.
cnxn = pyodbc.connect("DSN=FreeAgent")
cursor = cnxn.cursor()
cursor.columns()
rows = cursor.fetchall()
for row in rows:
     print(row.table_name, row.column_name)
exit()

8. These scripts insert, update, and then delete some FreeAgent data:

import pyodbc

cnxn = pyodbc.connect("DSN=FreeAgent")
cursor = cnxn.cursor()
sql = "INSERT INTO Bills (Contact, Reference, Dated_On, Due_On, Bill_Items)
VALUES (?, ?, ?, ?, ?)"
cursor.execute(sql, 'https://api.freeagent.com/v2/contacts/18727314', 'YEB021',
'2025-01-16', '2025-01-16',
'[{\"category\":\"https://api.freeagent.com/v2/categories/291\",\"description\":\
"YEB-line-2-standing-
charge\",\"sales_tax_rate\":\"20\",\"total_value_ex_tax\":6.99}]')
cursor.commit()
exit()

import pyodbc

cnxn = pyodbc.connect("DSN=FreeAgent")
cursor = cnxn.cursor()
sql = "UPDATE Bills SET Contact = 'Standing charges for second line.' WHERE Id =
?"
cursor.execute(sql, '31962267')
cursor.commit()
exit()

import pyodbc

cnxn = pyodbc.connect("DSN=FreeAgent")
cursor = cnxn.cursor()
sql = "DELETE FROM Bills WHERE Id = ?"
cursor.execute(sql, '31962267')
cursor.commit()
exit()

Further information

• Easysoft Python tutorials and code samples
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R

1. Install the Easysoft ODBC-FreeAgent Driver on same computer as R.
2. Configure an ODBC data source.
3. In R Console, check whether your R distribution supports ODBC.

library("RODBC")

4. Do one of the following:

- If you get no output, you have the ODBC library for R. Skip to the next step.

- If you get an "there is no package" error, install the ODBC library for R:

install.packages("RODBC")

5. Create and then use R to run this script, which retrieves some FreeAgent data:

library("RODBC")
# Replace FreeAgent with the name of your Easysoft ODBC-FreeAgent Driver data
source.
ch <- odbcConnect("FreeAgent")
sqlQuery(ch, paste("SELECT Contact FROM Bills"))
odbcClose(ch)
quit()

6. This script retrieves the tables and views in your Easysoft ODBC-FreeAgent Driver data source:

library("RODBC")
# Replace FreeAgent with the name of your Easysoft ODBC-FreeAgent Driver data
source.
ch <- odbcConnect("FreeAgent")
sqlTables(ch)
odbcClose(ch)
quit()

7. This script retrieves the names of the columns in the specified table or view:

library("RODBC")
# Replace FreeAgent with the name of your Easysoft ODBC-FreeAgent Driver data
source.
ch <- odbcConnect("FreeAgent")
# You may need to change the capitalisation of Bills to all upper case or all
lower case.
sqlColumns(ch, sqtable="Bills")
odbcClose(ch)
quit()

8. These scripts insert, update, and then delete some FreeAgent data:

library("RODBC")
ch <- odbcConnect("FreeAgent")
sqlQuery(ch, paste("INSERT INTO Bills (Contact, Reference, Dated_On, Due_On,
Bill_Items) VALUES ('https://api.freeagent.com/v2/contacts/18727314', 'YEB021',
'2025-01-16', '2025-01-16',
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'[{\"category\":\"https://api.freeagent.com/v2/categories/291\",\"description\":\
"YEB-line-2-standing-
charge\",\"sales_tax_rate\":\"20\",\"total_value_ex_tax\":6.99}]')"))
odbcClose(ch)
quit()

library("RODBC")
ch <- odbcConnect("FreeAgent")
sqlQuery(ch, paste("UPDATE Bills SET Contact = 'Standing charges for second
line.' WHERE Id = '31962267'"))
odbcClose(ch)
quit()

library("RODBC")
ch <- odbcConnect("FreeAgent")
sqlQuery(ch, paste("DELETE FROM Bills WHERE Id = '31962267'"))
odbcClose(ch)
quit()
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About the Easysoft ODBC-FreeAgent Driver

The Easysoft ODBC-FreeAgent Driver provides real-time access to FreeAgent data from any
application that supports ODBC.

• ODBC API and scalar functions

• Data type mapping

• SQL support
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ODBC API and scalar functions

API functions

Use this table to find out what ODBC API functions the Easysoft ODBC-FreeAgent Driver supports:

Function Status

SQLAllocConnect Supported

SQLAllocEnv Supported

SQLAllocHandle Supported

SQLAllocStmt Supported

SQLBindCol Supported

SQLBindParameter Supported

SQLBrowseConnect Not supported

SQLBulkOperations Not supported

SQLCancel Supported

SQLCloseCursor Supported

SQLColAttribute Supported

SQLColAttributes Supported

SQLColumnPrivileges Not supported

SQLColumns Supported

SQLConnect Supported

SQLCopyDesc Supported

SQLDataSources Supported

SQLDescribeCol Supported

SQLDescribeParam Supported

SQLDisconnect Supported

SQLDriverConnect Supported

SQLDrivers Supported

SQLEndTran Supported

SQLError Supported

SQLExecDirect Supported

SQLExecute Supported

SQLExtendedFetch Supported

SQLFetch Supported

SQLFetchScroll Supported

SQLForeignKeys Supported

SQLFreeConnect Supported
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Function Status

SQLFreeEnv Supported

SQLFreeHandle Supported

SQLFreeStmt Supported

SQLGetConnectAtt Supported

SQLGetConnectOption Supported

SQLGetCursorName Supported

SQLGetData Supported

SQLGetDescField Supported

SQLGetDescRec Supported

SQLGetDiagField Supported

SQLGetDiagRec Supported

SQLGetEnvAttr Supported

SQLGetFunctions Supported

SQLGetInfo Supported

SQLGetStmtAttr Supported

SQLGetStmtOption Supported

SQLGetTypeInfo Supported

SQLMoreResults Supported

SQLNativeSql Supported

SQLNumParams Supported

SQLNumResultCols Supported

SQLParamData Supported

SQLParamOptions Supported

SQLPrepare Supported

SQLPrimaryKeys Supported

SQLProcedureColumns Supported

SQLProcedures Supported

SQLPutData Supported

SQLRowCount Supported

SQLSetConnectAttr Supported

SQLSetConnectOption Supported

SQLSetCursorName Supported

SQLSetDescField Supported

SQLSetDescRec Supported

SQLSetEnvAttr Supported
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Function Status

SQLSetParam Supported

SQLSetPos Supported

SQLSetScrollOptions Supported

SQLSetStmtOption Supported

SQLSetStmtOption Supported

SQLSetStmtAttr Supported

SQLStatistics Supported

SQLTablePrivileges Not supported

SQLTables Supported

SQLTransact Supported

Scalar functions

The Easysoft ODBC-FreeAgent Driver supports a number of scalar functions:

• String functions

• Numeric functions

• Time, date, and interval functions

• System functions

• Conversion functions

Use either the SQL-92 or ODBC syntax with scalar functions. For example:

SELECT
  Invoice_Id,
  Customer_Name,
  EXTRACT(YEAR FROM Due_Date) as "Year"
FROM
  Invoice

SELECT
  Invoice_Id,
  Customer_Name,
  {fn EXTRACT(YEAR FROM Due_Date)} as "Year"
FROM
  Invoice

String functions

The Easysoft ODBC-FreeAgent Driver supports these string functions:

• ASCII(string_exp)

• BIT_LENGTH(string_exp)

• CHAR(code)

• CHAR_LENGTH(string_exp)

• CHARACTER_LENGTH(string_exp)`

• CONCAT(string_exp1, string_exp2)

• DIFFERENCE(string_exp1, string_exp2)
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• INSERT(string_exp1, start, length, string_exp2)

• LCASE(string_exp)

• LEFT(string_exp, count)

• LENGTH(string_exp)

• LOCATE(string_exp1, string_exp2[,start])

• LTRIM(string_exp)

• OCTET_LENGTH(string_exp)

• POSITION(char_exp IN char_exp)

• REPEAT(string_exp, count)

• REPLACE(string_exp1, string_exp2, string_exp3)

• RIGHT(string_exp, count)

• RTRIM(string_exp)

• SOUNDEX(string_exp)

• SPACE(count)

• SUBSTRING(string_exp, start, length)

• TRIM(string_exp)`

• UCASE(string_exp)

Numeric functions

The Easysoft ODBC-FreeAgent Driver supports these numeric functions:

• ABS(numeric_exp)

• ACOS(float_exp)

• ASIN(float_exp)

• ATAN(float_exp)

• ATAN2(float_exp1, float_exp2)

• CEILING(numeric_exp)

• COS(float_exp)

• COT(float_exp)

• DEGREES(numeric_exp)

• EXP(float_exp)

• FLOOR(numeric_exp)

• LOG(float_exp)

• LOG10(float_exp)

• MOD(integer_exp1, integer_exp2)

• PI()

• POWER(numeric_exp, integer_exp)

• RADIANS(numeric_exp)

• RAND([integer_exp])

• ROUND(numeric_exp, integer_exp)

• SIGN(numeric_exp)

• SIN(float_exp)

• SQRT(float_exp)

• TAN(float_exp)

• TRUNCATE(numeric_exp, integer_exp)

Time, date, and interval functions

The Easysoft ODBC-FreeAgent Driver supports these time, date, and interval functions:

• CURRENT_DATE()

• CURRENT_TIME[(time-precision)]

• CURRENT_TIMESTAMP[(timestamp-precision)]
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• CURDATE()

• CURTIME()

• DAYNAME(date_exp)

• DAYOFMONTH(date_exp)

• DAYOFWEEK(date_exp)

• DAYOFYEAR(date_exp)

• EXTRACT(extract-field FROM extract-source)

• HOUR(time_exp)

• MINUTE(time_exp)

• MONTH(date_exp)

• MONTHNAME(date_exp)

• NOW()

• QUARTER(date_exp)

• SECOND(time_exp)

• TIMESTAMPADD(interval, integer_exp, timestamp_exp)

• TIMESTAMPDIFF(interval, timestamp_exp1, timestamp_exp2)

• WEEK(date_exp)

• YEAR(date_exp)

System functions

The Easysoft ODBC-FreeAgent Driver supports these system functions:

• DATABASE()

• IFNULL(exp, value)

• USER()

Conversion functions

The Easysoft ODBC-FreeAgent Driver supports supports both the SQL-92 CAST function and the
ODBC CONVERT function for conversion between compatible data types.
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Data type mapping

The Easysoft ODBC-FreeAgent Driver maps FreeAgent data types to ODBC data types in this way:

FreeAgent data type ODBC data type

Array SQL_WLONGVARCHAR

Boolean SQL_BIT

Date SQL_TYPE_DATE

Decimal SQL_DOUBLE

Integer SQL_INTEGER

Object SQL_WLONGVARCHAR

Parameter SQL_TYPE_TIMESTAMP 
SQL_TYPE_DATE

SQL_WVARCHAR

String SQL_WVARCHAR 
SQL_WLONGVARCHAR 
SQL_TYPE_DATE 
SQL_TYPE_TIMESTAMP 
SQL_INTEGER 
SQL_DOUBLE

Timestamp SQL_TYPE_TIMESTAMP

URI SQL_WVARCHAR

Finding out more about data types on Windows

If you need more information about a data types, for example, the precision and scale, use
Microsoft’s ODBC Test to do this.

1. Download the version of ODBC Test that matches your application’s architecture from:

https://www.easysoft.com/ftp/pub/utils/windows/odbc-test/

2. Copy both files to a folder on the machine where Easysoft ODBC-FreeAgent Driver is installed.
3. Double-click odbcte32.exe.
4. Select Con > Full Connect.
5. Choose your Easysoft ODBC-FreeAgent Driver data source from the list.
6. Choose Catalog > SQLGetTypeInfo.
7. Either choose SQL_ALL_TYPES=0 (1.0) or a specific data type from the DataType list.
8. Choose Results > Get Data All.
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SQL support

The Easysoft ODBC-FreeAgent Driver supports these SQL statements, clauses, and operators:

• SELECT

• SELECT DISTINCT

• WHERE

• ORDER BY

• AND

• OR

• NOT

• INSERT INTO

• NULL

• UPDATE

• DELETE

• TOP

• MIN

• MAX

• COUNT

• SUM

• AVG

• LIKE

• WILDCARDS

• IN

• BETWEEN

• ALIASES

• JOINS

• UNION

• GROUP BY

• HAVING

• EXISTS

• CASE

Example queries

• To fetch all records from a table, use the asterisk symbol (*) in your queries. For example:

SELECT * FROM Invoices

• To only fetch records whose values are different, use DISTINCT. For example:

-- Which different customers do we invoice?
SELECT DISTINCT Contact_Name AS Different_Contact_Name FROM Invoices
-- How many different customers do we invoice?
SELECT COUNT(DISTINCT Contact_Name) AS Different_Contact_Total FROM Invoices
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• To filter records, use WHERE. For example:

SELECT
  Id,
  Contact_Name,
  Total_Value
FROM
  Invoice
WHERE
  Currency = 'USD'

SELECT
  Id,
  Contact_Name,
  Total_Value
FROM
  Invoices
WHERE
  Currency = 'USD'
  OR Currency = 'EUR'

SELECT
  Id,
  Contact_Name,
  Total_Value
FROM
  Invoices
WHERE
  Currency = 'USD'
  AND Total_Value < 1000

You can also supply a WHERE clause value as a parameter. For example, to do this in Python:

cursor.execute("SELECT
  Id,
  Contact_Name,
  Total_Value
FROM
  Invoices
WHERE
  Currency = ?", ['USD'])
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• To fetch records that don’t match the WHERE clause pattern use NOT. For example:

SELECT
  Id,
  Contact_Name,
  Total_Value
FROM
  Invoices
WHERE
  NOT Currency = 'USD'

• To sort the result set in either ascending or descending order, use ORDER BY. For example:

SELECT
  Id,
  Contact_Name,
  Net_Value
FROM
  Invoices
ORDER BY
  Net_Value ASC

SELECT
  *
FROM
  Contacts
ORDER BY
  (
    CASE
      WHEN Last_Name IS NULL THEN Organisation_Name
      ELSE Last_Name
    END
  );
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• To group a result set into summary rows, use GROUP BY. For example:

SELECT
    COUNT(Id) As "Number",
    Currency
FROM
    Invoices
GROUP BY
    Currency

SELECT
  COUNT(Id) As "Number",
  Currency
FROM
  Invoices
GROUP BY
  Currency
HAVING
  COUNT(Id) > 10;

• To do calculations based on result set vales, use the SQL aggregate functions MIN(), MAX(),
COUNT(), SUM(), and AVG(). For example:

SELECT Max(Total_Value) FROM Invoices
SELECT Sum(Total_Value) FROM Invoices

In addition, you can use these scalar funtions.

• To convert between compatible data types, use CAST or CONVERT. For example:

SELECT CAST(Total_Value AS Char(100))FROM Invoices
SELECT {fn CONVERT(Total_Value, SQL_CHAR)} FROM Invoices

• To fetch records that contain column values between a given range, use BETWEEN. For
example:

SELECT Id, Contact_Name FROM Invoices WHERE Total_Value BETWEEN 10 AND 20
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• To combine the result set of two or more SELECT statements, use UNION. For example:

SELECT
    Group_Description,
    Description,
    Id,
    Url,
    Nominal_Code,
    Allowable_For_Tax,
    Tax_Reporting_Name,
    Auto_Sales_Tax_Rate
FROM
    Categories_Admin_Expenses
UNION ALL
SELECT
    Group_Description,
    Description,
    Id,
    Url,
    Nominal_Code,
    Allowable_For_Tax,
    Tax_Reporting_Name,
    Auto_Sales_Tax_Rate
FROM
    Categories_Cost_Of_Sales
UNION ALL
SELECT
    REPLACE (Url, Url, 'General') AS Group_Description,
    Description,
    Id,
    Url,
    Nominal_Code,
    CAST(NULL AS bit) AS Allowable_For_Tax,
    Tax_Reporting_Name,
    CAST(NULL AS double) AS Auto_Sales_Tax_Rate
FROM
    Categories_General
UNION ALL
SELECT
    Group_Description,
    Description,
    Id,
    Url,
    Nominal_Code,
    CAST(NULL AS bit) AS Allowable_For_Tax,
    REPLACE (Url, Url, 'N/A') AS Tax_Reporting_Name,
    Auto_Sales_Tax_Rate
FROM
    Categories_Income

• To combine rows from two or more tables, use JOIN. For example:

72  Example queries



SELECT
    a.Name,
    bt.*
FROM
    Bank_accounts a
    LEFT JOIN Bank_Transactions bt ON bt.Bank_Account = a.URL

• To fetch records that contain column values matching a search pattern, use LIKE. For example:

SELECT Id FROM Invoices WHERE Contact_Name LIKE 'E%'
SELECT Id FROM Invoices WHERE Contact_Name LIKE '_asysoft'

• To search for columns without a value (NULL) or with a value (non NULL), use either IS NULL or
IS NOT NULL. For example:

SELECT Id, Contact_Name, Total_Value FROM Invoices WHERE Include_Estimates IS
NULL
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• To specify multiple values in a WHERE clause, you can use IN as an alternative to OR. For
example:

SELECT
  Id,
  Contact_Name,
  Total_Value
FROM
  Invoices
WHERE
  Currency = 'USD'
  OR Currency = 'EUR'
  OR Currency = 'GBP'

can be replaced with:

SELECT
  Id,
  Contact_Name,
  Total_Value
FROM
  Invoices
WHERE
  Currency IN ('USD', 'EUR', 'GBP');

• To set the maximum number of records to return, use TOP. For example:

SELECT TOP 10 Id, Contact_Name FROM Invoices

• To test for the existence of records in a subquery, use EXISTS. For example:

SELECT
  Contact_Name
FROM
  Invoices
WHERE
  EXISTS (
    SELECT
      First_Name,
      Last_Name
    FROM
      Contacts
    WHERE
      Invoices.Contact_Id = Contacts.Id
      AND Currency = 'USD'
  )
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Example inserts, updates, and deletes

• To insert a FreeAgent record, use INSERT INTO. For example:

INSERT INTO
    Bills (
        Contact,
        Reference,
        Dated_On,
        Due_On,
        Bill_Items
    )
VALUES
    (
        'https://api.freeagent.com/v2/contacts/18727314',
        'YEB021',
        '2025-01-16',
        '2025-01-16',
 
'[{\"category\":\"https://api.freeagent.com/v2/categories/291\",\"description\":\
"YEB-line-2-standing-
charge\",\"sales_tax_rate\":\"20\",\"total_value_ex_tax\":6.99}]'
    )

• Here’s a SQL Server linked server example:

EXEC ('INSERT INTO Bills (Contact, Reference, Dated_On, Due_On, Bill_Items)
VALUES (''https://api.freeagent.com/v2/contacts/18727314'' , ''YEB021'' , ''2025-
01-16'' , ''2025-01-16'' ,
''[{\"category\":\"https://api.freeagent.com/v2/categories/291\",\"description\":
\"YEB-line-2-standing-
charge\",\"sales_tax_rate\":\"20\",\"total_value_ex_tax\":6.99}]'')')
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• Here’s an Oracle linked table example:

DECLARE
  num_rows integer;
BEGIN
num_rows:=DBMS_HS_PASSTHROUGH.EXECUTE_IMMEDIATE@FreeAgentLink
('INSERT INTO Bills (Contact, Reference, Dated_On, Due_On, Bill_Items) VALUES
(''https://api.freeagent.com/v2/contacts/18727314'', ''YEB021'', ''2025-01-16'',
''2025-01-16'',
''[{\"category\":\"https://api.freeagent.com/v2/categories/291\",\"description\":
\"YEB-line-2-standing-
charge\",\"sales_tax_rate\":\"20\",\"total_value_ex_tax\":6.99}]'')');
END;
/

• The Easysoft ODBC-FreeAgent Driver also supports parameterized inserts. Here’s an example
of doing this in PHP:

$stmt = odbc_prepare($cnx, "INSERT INTO Bills (Contact, Reference, Dated_On,
Due_On, Bill_Items) VALUES (?, ?, ?, ?, ?)");

$success = odbc_execute($stmt,
array('https://api.freeagent.com/v2/contacts/18727314', 'YEB021', '2025-01-16',
'2025-01-16',
'[{\"category\":\"https://api.freeagent.com/v2/categories/291\",\"description\":\
"YEB-line-2-standing-
charge\",\"sales_tax_rate\":\"20\",\"total_value_ex_tax\":6.99}]'));

• To update a FreeAgent record, use UPDATE. For example:

UPDATE Bills
SET
  Contact = 'Standing charges for second line.'
WHERE
  Account_Id = '31962267'

The Easysoft ODBC-FreeAgent Driver also supports parameterized updates. Here’s an example
of doing this in Perl:

my $sth = $dbh->prepare('UPDATE Bills SET Contact = \'Standing charges for second
line.\' WHERE Id = ?')
    or die "Can't prepare statement: $DBI::errstr";

$sth->execute('31962267');
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• To delete a FreeAgent record, use DELETE. For example:

-- Delete (mark inactive) a bank account
DELETE FROM Bills WHERE Id = '31962267'

The Easysoft ODBC-FreeAgent Driver also supports parameterized deletes. Here’s an example
of doing this in Python:

sql = "DELETE FROM Bills WHERE Id = ?"
cursor.execute(sql, '31962267')
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Tables

The Easysoft ODBC-FreeAgent Driver presents FreeAgent resources as a set of tables and views.
This allows you to work with FreeAgent data by using SQL that you either enter yourself or your
application builds for you.

Note that some table and view columns may not be applicable to your edition of FreeAgent.

The tables are:

• Bank_Accounts

• Bank_Feeds

• Bank_Transaction_Explanations

• Bank_Transaction_Explanations_Attachment

• Bills

• Capital_Asset_Types

• Categories_Admin_Expenses

• Categories_Cost_Of_Sales

• Categories_General

• Categories_Income

• Contacts

• Credit_Note_Reconciliations

• Credit_Notes

• Estimates

• Expenses

• Final_Accounts_Reports

• Hire_Purchases

• Invoices

• Journal_Sets

• Notes

• Price_List_Items

• Projects

• Properties

• Recurring_Invoices

• Sales_Tax_Periods

• Tasks

• Timeslips

• Users
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The views are:

• API

• Balance_Sheet

• Balance_Sheet_Capital_Assets

• Balance_Sheet_Current_Assets

• Balance_Sheet_Current_Liabilities

• Balance_Sheet_Opening_Balances

• Balance_Sheet_Owners_Equity

• Bank_Accounts_Marked_For_Review_Category_Group_Counts

• Bank_Transactions

• Bank_Transactions_Explanations

• Bill_Items

• Capital_Assets

• Capital_Assets History

• Cashflow

• Cashflow_Incoming

• Cashflow_Outgoing

• Cis_Bands

• Company

• Company_Annual_Accounting_Periods

• Company_Business_Categories

• Company_Locked_Attributes

• Company_Sales_Tax_Rates

• Company_Tax_Timeline

• Corporation_Tax_Returns

• Credit_Note_Items

• Email_Addresses

• Invoice_Items

• Journal_Sets_Bank_Accounts

• Journal_Sets_Journal_Entries

• Journal_Sets_Stock_Items

• Opening_Balance_Summary

• Payroll_Payslips

• Payroll_Periods

• Payroll_Profiles

• Profit_And_Loss

• Profit_And_Loss_Less

• Recurring_Invoice_Invoice_Items

• Stock_Items

• Transactions

• Trial_Balance_Summary

• Vat_Return_Payments

• Vat_Returns
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Bank_Accounts table

Column Type

Id String

Url URI

Type String

View String

Email String

Account_Number String

Current_Balance Decimal

Unexplained_Transaction_Count Integer

Name String

Opening_Balance Decimal

Manually_Added_Transaction_Count Integer

Updated_At Timestamp

Is_Personal Boolean

Total_Count Integer

Is_Primary Boolean

Currency String

Status String

Marked_For_Review_Count Integer

Latest_Activity_Date String

Bank_Code String

Created_At Timestamp

Bank_Feed_Enabled Boolean

Bank_Guess_Enabled Boolean

Bank_Name String

Sort_Code String

Secondary_Sort_Code String

Iban String

Bic String

Default_Property String

Marked_For_Review_Category_Group_Counts Array

Examples

SELECT
    Id,
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    [Name],
    Current_Balance,
    Updated_At
FROM
    Bank_Accounts
WHERE
    Current_Balance < 10000

INSERT INTO
    Bank_Accounts (
        [Type],
        [Name],
        [Currency],
        [Is_Personal],
        [Is_Primary],
        [Status],
        [Bank_Name],
        [Opening_Balance],
        [Bank_Guess_Enabled],
        [Account_Number],
        [Sort_Code],
        [Secondary_Sort_Code],
        [Iban],
        [Bic]
    )
VALUES
    (
        'StandardBankAccount',
        'Barclays EUR',
        'EUR',
        'false',
        'false',
        'active',
        'Barclays Bank',
        '100000',
        'false',
        '223344557',
        '22-11-21',
        '22-11-22',
        'GB10 BUKB 111111223344557',
        'BUKBGB22'
    )
UPDATE Bank_Accounts
SET
    [Name] = 'Barclays EUR2'
WHERE
    [Name] = 'Barclays EUR'

DELETE FROM Bank_Accounts
WHERE
    [Name] = 'Barclays EUR2'
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Bank_Feeds table

Column Type

Id String

Url URI

Bank_Service_Name String

State String

Feed_Type String

Created_At Timestamp

Bank_Account_Id String

Bank_Account URI

Updated_At Timestamp

Sca_Expires_At Timestamp

Examples

SELECT
    *
FROM
    Bank_Feeds
WHERE
    Updated_At > '2024-11-20'

82  Examples



Bank_Transaction_Explanations table

Column Type

Id String

Url URI

Bank_Account_Id String

Bank_Account URI

Bank_Transaction_Id String

Bank_Transaction URI

Category_Id String

Category String

Paid_Invoice_Id String

Paid_Invoice String

Guessed_Category String

Gross_Value Decimal

Dated_On String

Description String

Is_Locked Boolean

Transaction_Description String

Foreign_Currency_Value Decimal

Has_Pending_Operation Boolean

Transfer_Value Decimal

Is_Deletable Boolean

Type String

Is_Money_Paid_To_User Boolean

Is_Money_In Boolean

Is_Money_Out Boolean

Marked_For_Review Boolean

Guess_Rule_Name String

Updated_At Timestamp

Detail String

Sales_Tax_Status String

Sales_Tax_Value Decimal

Sales_Tax_Rate Decimal

Linked_Transfer_Account String

Linked_Transfer_Explanation String

From_Date Parameter
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Column Type

To_Date Parameter

Updated_Since Parameter

Transaction_Id String

Uploaded_At Timestamp

Second_Sales_Tax_Status String

Second_Sales_Tax_Value Decimal

Second_Sales_Tax_Rate Decimal

Paid_Bill_Id String

Paid_Bill String

Locked_Attributes Array

Attachment Object

Examples

SELECT
    *
FROM
    Bank_Transactions
WHERE
    Id = '577790804'
SELECT
    *
FROM
    Bank_Transactions
WHERE
    Bank_Account = 'https://api.freeagent.com/v2/bank_accounts/1555435'

INSERT INTO
    Bank_Transaction_Explanations (
        bank_transaction,
        bank_account,
        dated_on,
        description,
        category,
        gross_value,
        sales_tax_status,
        sales_tax_rate
    )
VALUES
    (
        'https://api.freeagent.com/v2/bank_transactions/577790779',
        'https://api.freeagent.com/v2/bank_accounts/1555435',
        '2024-11-26',
        'FEE description.',
        'https://api.freeagent.com/v2/categories/291',
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        -471,
        'TAXABLE',
        20
    )

UPDATE Bank_Transaction_Explanations
SET
    Description = 'New FEE description text.'
WHERE
    Id = '532804092'
DELETE FROM Bank_Transaction_Explanations
WHERE
    Id = '532762173'
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Bank_Transaction_Explanations_Attachment table

Column Type

Id String

Url URI

Bank_Account_Id String

Bank_Account String

Bank_Transaction_Id String

Bank_Transaction String

Category_Id String

Category String

Paid_Invoice_Id String

Paid_Invoice String

Guessed_Category String

Gross_Value Decimal

Dated_On String

Description String

Is_Locked Boolean

Transaction_Description String

Foreign_Currency_Value Decimal

Has_Pending_Operation Boolean

Transfer_Value Decimal

Is_Deletable Boolean

Type String

Is_Money_Paid_To_User Boolean

Is_Money_In Boolean

Is_Money_Out Boolean

Marked_For_Review Boolean

Guess_Rule_Name String

Updated_At Timestamp

Detail String

Sales_Tax_Status String

Sales_Tax_Value Decimal

Sales_Tax_Rate Decimal

Linked_Transfer_Account String

Linked_Transfer_Explanation String

From_Date Parameter
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Column Type

To_Date Parameter

Updated_Since Parameter

Transaction_Id String

Uploaded_At Timestamp

Second_Sales_Tax_Status String

Second_Sales_Tax_Value Decimal

Second_Sales_Tax_Rate Decimal

Paid_Bill_Id String

Paid_Bill String

Locked_Attributes Array

Attachment_Url_Id URI

Attachment_Url URI

Attachment_Content_Src String

Attachment_Description String

Attachment_Content_Src_Medium String

Attachment_Content_Src_Small String

Attachment_File_Name String

Attachment_File_Size Integer

Attachment_Expires_At Timestamp

Attachment_Content_Type String
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Bills table

Column Type

Id String

Url URI

Total_Value Decimal

Status String

Paid_Value Decimal

Contact String

Project String

Created_At Timestamp

Updated_At Timestamp

Dated_On String

Reference String

Native_Due_Value Decimal

Due_On String

Net_Value Decimal

Paid_On String

Long_Status String

Due_Value Decimal

Currency String

Input_Total_Values_Inc_Tax Boolean

Sales_Tax_Value Decimal

Is_Paid_By_Hire_Purchase Boolean

Locked_Reason String

Contact_Name String

Comments String

Second_Sales_Tax_Value Decimal

Recurring String

View String

From_Date Parameter

To_Date Parameter

Updated_Since Parameter

Locked_Attributes Array

Bill_Items Array

Examples
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SELECT
    *
FROM
    Bills
WHERE
    Status = 'Open'

INSERT INTO
    Bills (Contact, Reference, Dated_On, Due_On, Bill_Items)
VALUES
    (
        'https://api.freeagent.com/v2/contacts/18541472',
        'YEB002',
        '2024-11-28',
        '2024-12-28',
 
'[{"category":"https://api.freeagent.com/v2/categories/291","description":"YEB Line
2 standing charge","sales_tax_rate":"20","total_value_ex_tax":49.99}]'
    )

UPDATE Bills
SET
    Comments = 'Standing charge for second line.'
WHERE
    Id = '31467166'

DELETE FROM Bills
WHERE
    Id = '31467166'
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Capital_Asset_Types table

Column Type

Id String

Url URI

Name String

Created_At Timestamp

System_Default Boolean

Updated_At Timestamp

Examples

SELECT
    *
FROM
    Capital_Asset_Types
WHERE
    System_Default = False

INSERT INTO
    Capital_Asset_Types ([Name])
VALUES
    ('Trucks.')

DELETE FROM Capital_Asset_Types
WHERE
    Id = '5234506'

90  Examples



Categories_Admin_Expenses table

Column Type

Nominal_Code String

Id String

Url URI

Description String

Auto_Sales_Tax_Rate Decimal

Group_Description String

Allowable_For_Tax Boolean

Tax_Reporting_Name String

Category_Group String

Examples

SELECT
    Group_Description,
    [Description],
    Id,
    [Url],
    Nominal_Code,
    Allowable_For_Tax,
    Tax_Reporting_Name,
    Auto_Sales_Tax_Rate
FROM
    Categories_Admin_Expenses
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Categories_Cost_Of_Sales table

Column Type

Nominal_Code String

Id String

Url URI

Allowable_For_Tax Boolean

Description String

Group_Description String

Tax_Reporting_Name String

Auto_Sales_Tax_Rate Decimal

Category_Group String

Examples

SELECT
    Group_Description,
    [Description],
    Id,
    [Url],
    Nominal_Code,
    Allowable_For_Tax,
    Tax_Reporting_Name,
    Auto_Sales_Tax_Rate
FROM
    Categories_Cost_Of_Sales
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Categories_General table

Column Type

Nominal_Code String

Id String

Url URI

Description String

Tax_Reporting_Name String

Category_Group String

Examples

SELECT
    REPLACE (Url, Url, 'General') AS Group_Description,
    [Description],
    Id,
    [Url],
    Nominal_Code,
    CAST(NULL AS bit) AS Allowable_For_Tax,
    Tax_Reporting_Name,
    CAST(NULL as double) AS Auto_Sales_Tax_Rate
FROM
    Categories_General
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Categories_Income table

Column Type

Nominal_Code String

Id String

Url URI

Description String

Group_Description String

Auto_Sales_Tax_Rate Decimal

Category_Group String

Examples

SELECT
    Group_Description,
    [Description],
    Id,
    [Url],
    Nominal_Code,
    CAST(NULL AS bit) AS Allowable_For_Tax,
    REPLACE (Url, Url, 'N/A') AS Tax_Reporting_Name,
    Auto_Sales_Tax_Rate
FROM
    Categories_Income
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Contacts table

Column Type

Id String

Url URI

Active_Projects_Count Integer

First_Name String

Last_Name String

Address1 String

Address2 String

Address3 String

Town String

Region String

Country String

Postcode String

Phone_Number String

Organisation_Name String

Email String

Billing_Email String

Default_Payment_Terms_In_Days Integer

Sales_Tax_Registration_Number String

Mobile String

Contact_Name_On_Invoices Boolean

Created_At Timestamp

Status String

Updated_At Timestamp

Uses_Contact_Level_Email_Settings Boolean

Charge_Sales_Tax String

Locale String

Account_Balance Decimal

Uses_Contact_Invoice_Sequence Boolean

Emails_Thank_You_Notes Boolean

Emails_Invoices_Automatically Boolean

Emails_Payment_Reminders Boolean

Examples

SELECT
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    Id
FROM
    Contacts
WHERE
    Email = 'ta@example.com'

INSERT INTO
    Contacts (
        First_Name,
        Last_Name,
        Email,
        Billing_Email,
        Phone_Number,
        Mobile,
        Address1,
        Address2,
        Address3,
        Town,
        Region,
        Postcode,
        Country,
        Uses_Contact_Invoice_Sequence,
        Contact_Name_On_Invoices,
        Charge_Sales_Tax,
        Sales_Tax_Registration_Number,
        [Status],
        Default_Payment_Terms_In_Days,
        Locale
    )
VALUES
    (
        'Thomas, ' Axen ', ' ta@example.com ', ' bills@example.com ', ' (123) 555
-0101 ', ' (321) 555 -0101 ', ' 123 Third Street ', '', '', ' Los Angeles ', ' CA
', ' 99999 ', USA',
        'false',
        'true',
        'Always',
        'US123456789',
        'Active',
        '30',
        'en'
    )

UPDATE Contacts
SET
    Mobile = '(321)555-0101'
WHERE
    Email = 'ta@example.com'
DELETE FROM Contacts
WHERE
    Id = '18482080'
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Credit_Note_Reconciliations table

Column Type

Id Integer

Url URI

From_Date Parameter

To_Date Parameter

Updated_Since Parameter

Credit_Note_Id String

Credit_Note URI

Invoice_Id String

Invoice URI

Gross_Value Decimal

Dated_On String

Exchange_Rate Decimal

Currency String

Created_At Timestamp

Updated_At Timestamp

Examples

SELECT
    *
FROM
    Credit_Note_Reconciliations

INSERT INTO
    Credit_Note_Reconciliations (
        Dated_On,
        Currency,
        Exchange_Rate,
        Gross_Value,
        Invoice,
        Credit_Note
    )
VALUES
    (
        '2024-12-06',
        'USD',
        '1',
        '100',
        'https://api.freeagent.com/v2/invoices/73622204',
        'https://api.freeagent.com/v2/credit_notes/73959649'
    )
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UPDATE Credit_Note_Reconciliations
SET
    Gross_Value = 200
WHERE
    Id = '357053'

DELETE FROM Credit_Note_Reconciliations
WHERE
    Id = '357053'
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Credit_Notes table

Column Type

Id Integer

Url URI

Contact_Id String

Contact URI

Due_Value Decimal

Updated_At Timestamp

Payment_Terms_In_Days Integer

Due_On String

Omit_Header Boolean

Dated_On String

Reference String

Status String

Currency String

Total_Value Decimal

Involves_Sales_Tax Boolean

Exchange_Rate Decimal

Net_Value Decimal

Is_Interim_Uk_Vat Boolean

Refunded_Value Decimal

Long_Status String

Created_At Timestamp

Bank_Account_Id String

Bank_Account String

Contact_Name String

Sales_Tax_Value Decimal

Refunded_On String

Comments String

Second_Sales_Tax_Value Decimal

Credit_Note_Items Array

Examples

SELECT
    *
FROM
    Credit_Notes
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WHERE
    Status <> 'Refunded'

INSERT INTO
    Credit_Notes (Contact, Dated_On, Currency, Credit_Note_Items)
VALUES
    (
        'https://api.freeagent.com/v2/contacts/18494140',
        '2024-11-27',
        'GBP',
        '[{"item_type":"Days","quantity":"1","price":"-
999.99","description":"Consultancy Days"}]'
    )

UPDATE Credit_Notes
SET
    Credit_Note_Items = '[{"item_type":"Days","quantity":"4","price":"-
999.99","description":"Consultancy
Days"},{"item_type":"Hours","quantity":"32","price":"-
172.22","description":"Developer Hours"}]'
WHERE
    Id = '73934615'

DELETE FROM Credit_Notes
WHERE
    Id = '73934615'
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Estimates table

Column Type

Id String

Url URI

Contact_Id String

Contact URI

Project_Id String

Project URI

Dated_On String

Status String

Estimate_Type String

Created_At Timestamp

Include_Sales_Tax_On_Total_Value Boolean

Total_Value Decimal

Currency String

Reference String

Involves_Sales_Tax Boolean

Net_Value Decimal

Is_Interim_Uk_Vat Boolean

Contact_Name String

Updated_At Timestamp

Second_Sales_Tax_Value Decimal

Sales_Tax_Value Decimal

Notes String

Estimate_Items Array

Examples

SELECT
    *
FROM
    Estimates
WHERE
    Estimate_Type = 'Quote'

INSERT INTO
    Estimates (
        Contact,
        Dated_On,
        [Status],
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        Estimate_Type,
        Currency,
        Reference,
        Estimate_Items
    )
VALUES
    (
        'https://api.freeagent.com/v2/contacts/18494140',
        '2024-11-27',
        'Draft',
        'Quote',
        'USD',
        'Customer Ref 2',
 
'[{"item_type":"Days","quantity":"2","price":"999.99","description":"Consultancy
Days"}]'
    )

UPDATE Estimates
SET
    Estimate_Items =
'[{"item_type":"Days","quantity":"4","price":"999.99","description":"Consultancy
Days"},{"item_type":"Hours","quantity":"32","price":"172.22","description":"Develop
er Hours"}]'
WHERE
    Id = '5771094'

DELETE FROM Estimates
WHERE
    Id = '5771094'
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Expenses table

Column Type

Id Integer

Url URI

From_Date Parameter

To_Date Parameter

Updated_Since Parameter

Sales_Tax_Status String

Attachment_File_Size Integer

Attachment_Content_Src_Medium String

Attachment_Url URI

Attachment_Content_Src String

Attachment_Content_Type String

Attachment_Content_Src_Small String

Attachment_Expires_At String

Attachment_File_Name String

User_Id Integer

User URI

Currency String

Category_Id Integer

Category URI or String

Locked_Attributes Array

Sales_Tax_Rate Decimal

Dated_On String

Gross_Value Decimal

Updated_At Timestamp

Native_Gross_Value Decimal

Sales_Tax_Value Decimal

Native_Sales_Tax_Value Decimal

Description String

Created_At Timestamp

Locked_Reason String

Second_Sales_Tax_Rate Decimal

Second_Sales_Tax_Value Decimal

Second_Sales_Tax_Status String
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Examples

SELECT
    *
FROM
    Expenses

INSERT INTO
    Expenses (
        User,
        Category,
        Dated_On,
        Currency,
        Gross_Value,
        Sales_Tax_Rate,
        Sales_Tax_Status,
        [Description]
    )
VALUES
    (
        'https://api.freeagent.com/v2/users/1861284',
        'https://api.freeagent.com/v2/categories/287',
        '2024-12-03',
        'GBP',
        '-200',
        '20',
        'TAXABLE',
        'Overnight stay'
    )

UPDATE Expenses
SET
    Description = 'Hotel Stay'
WHERE
    Id = '53063365'

DELETE FROM Expenses
WHERE
    Id = '53063365'
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Final_Accounts_Reports table

Column Type

Id String

Url URI

Period_Ends_On String

Period_Starts_On String

Filing_Due_On String

Filing_Status String

Examples

SELECT
    *
FROM
    Final_Accounts_Reports
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Hire_Purchases table

Column Type

Id String

Url URI

Description URI

Bill URI

Liabilities_Over_One_Year_Category URI

Liabilities_Under_One_Year_Category URI

Examples

SELECT
    *
FROM
    Hire_Purchases
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Invoices table

Column Type

Id String

Url URI

Exchange_Rate Decimal

Contact_Id String

Contact URI

Total_Value Decimal

Omit_Header Boolean

Updated_At Timestamp

Dated_On String

Currency String

Due_On String

Refunded_Value String

Contact_Name String

Is_Interim_Uk_Vat Boolean

Reference String

Net_Value Decimal

Involves_Sales_Tax Boolean

Payment_Terms_In_Days Integer

Due_Value Decimal

Status String

Long_Status String

Created_At Timestamp

Bank_Account_Id String

Bank_Account String

Paid_Value Decimal

Always_Show_Bic_And_Iban Boolean

Paid_On String

Payment_Methods_Paypal Boolean

Payment_Methods_Stripe Boolean

Send_Reminder_Emails Boolean

Send_New_Invoice_Emails Boolean

Send_Thank_You_Emails Boolean

Sales_Tax_Value Decimal

Second_Sales_Tax_Value Decimal
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Column Type

Client_Contact_Name String

Project URI

Po_Reference String

Discount_Percent Decimal

Discount_Value Decimal

Comments String

Show_Project_Name Boolean

Written_Off_Date String

Include_Timeslips String

Include_Expenses String

Include_Estimates String

Recurring_Invoice String

Invoice_Items Array

Payment_Methods Object

Examples

INSERT INTO
    Invoices (
        Contact,
        Dated_On,
        Due_On,
        Currency,
        Exchange_Rate,
        Payment_Terms_In_Days,
        Net_Value,
        Invoice_Items
    )
VALUES
    (
        'https://api.freeagent.com/v2/contacts/18494140',
        '2024-11-27',
        '2024-11-27',
        'USD',
        '0.7263561',
        '30',
        '7649.88',
 
'[{"item_type":"Days","quantity":"5","price":"1249.99","description":"CON001 :
Consultancy"},{"item_type":"Stock","quantity":"7","price":"199.99","description":"W
D 1TB 3.5 : Western Digital 1TB 3.5 hard disk
drive","stock_item":"https://api.freeagent.com/v2/stock_items/236156"}]'
    )
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Journal_Sets table

Column Type

Id Integer

Url URI

From_Date Parameter

To_Date Parameter

Updated_Since Parameter

Tag Parameter

Updated_At Timestamp

Dated_On String

Description String

Journal_Entries Array

Bank_Accounts Array

Stock_Items Array

Examples

SELECT
    *
FROM
    Journal_Sets
WHERE
    Id = '5754992'

INSERT INTO
    Journal_Sets (Dated_On, [Description], Journal_Entries)
VALUES
    (
        '2024-12-03',
        'Sample Journal Created',
 
'[{"category":"https://api.freeagent.com/v2/categories/363","description":"Sample
journal line
1","debit_value":"10"},{"category":"https://api.freeagent.com/v2/categories/001","d
escription":"Sample journal line 2","debit_value":"-10"}]'
    )

UPDATE Journal_Sets
SET
    Journal_Entries = REPLACE (
        REPLACE (
            Journal_Entries,
            '""debit_value"":""10.0""',
            '""debit_value"":""10.99""'
        ),
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        '""debit_value"":""-10.0""',
        '""debit_value"":""-10.99""'
    )
WHERE
    Id = '5762019'

DELETE FROM Journal_Sets
WHERE
    Id = '5762019'
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Notes table

Column Type

Id Integer

Url URI

Project String

Contact String

Note String

Parent_Id Integer

Parent_Url URI

Author String

Created_At Timestamp

Updated_At Timestamp

Examples

SELECT
    *
FROM
    Notes
WHERE
    Contact = 'https://api.freeagent.com/v2/contacts/18494140'
INSERT INTO
    Notes (Note, Contact)
VALUES
    (
        'A new note',
        'https://api.freeagent.com/v2/contacts/18494140'
    )

UPDATE Notes
SET
    Name = 'Thomas Axen'
WHERE
    Id = '906732'

DELETE FROM Notes
WHERE
    Id = '906732'

Examples  111



Price_List_Items table

Column Type

Id Integer

Url URI

Sales_Tax_Rate String

Item_Type String

Created_At Timestamp

Code String

Quantity Decimal

Price Decimal

Description String

Second_Sales_Tax_Rate Decimal

Vat_Status String

Category_Id String

Category URI

Updated_At Timestamp

Stock_Item_Id String

Stock_Item URI

Examples

SELECT
    *
FROM
    Price_List_Items
WHERE
    Item_Type = 'Months'

INSERT INTO
    Price_List_Items (
        Code,
        Quantity,
        Item_Type,
        [Description],
        Price,
        Sales_Tax_Rate,
        Category
    )
VALUES
    (
        'CS001',
        '1',
        'Months',
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        'Monthly Cloud Storage',
        '9.99',
        '20',
        'https://api.freeagent.com/v2/categories/001'
    )

UPDATE Price_List_Items
SET
    Price = 10.99
WHERE
    Code = 'CS001'

DELETE FROM Price_List_Items
WHERE
    Code = 'CS001'
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Projects table

Column Type

Id Integer

Url URI

Currency String

Name String

Budget_Units String

Contact_Id String

Contact URI

Contact_Name String

Billing_Period String

Status String

Uses_Project_Invoice_Sequence Boolean

Created_At Timestamp

Contract_Po_Reference String

Updated_At Timestamp

Starts_On String

Is_Ir35 Boolean

Ends_On String

Include_Unbilled_Time_In_Profitability Boolean

Budget Integer

Hours_Per_Day Decimal

Normal_Billing_Rate Decimal

Is_Deletable Boolean

Examples

SELECT
    *
FROM
    Projects
WHERE
    Status = 'Active'

INSERT INTO
    Projects (
        [Name],
        Contact,
        [Status],
        Currency,
        Budget_Units,
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        Budget,
        Starts_On,
        Is_Deletable
    )
VALUES
    (
        'Consultancy to add features.',
        'https://api.freeagent.com/v2/contacts/18494140',
        'Active',
        'USD',
        'Monetary',
        '9999',
        '2025-01-03',
        'true'
    )

UPDATE Projects
SET
    Name = 'New Features'
WHERE
    Id = '4088693'

DELETE FROM Projects
WHERE
    Id = '4088697'
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Properties table

Column Type

Id Integer

Url URI

Address1 String

Address2 String

Address3 String

Town String

Region String

Postcode String

Country String

Examples

SELECT
    *
FROM
    Properties
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Recurring_Invoices table

Column Type

Id Integer

Url URI

Net_Value Decimal

Recurring_End_Date String

Next_Recurs_On String

Contact_Id String

Contact String

Send_New_Invoice_Emails Boolean

Comments String

Contact_Name String

Dated_On String

Recurring_Status String

Frequency String

Reference String

Created_At Timestamp

Due_Value Decimal

Profile_Id String

Currency String

Exchange_Rate Decimal

Second_Sales_Tax_Value Decimal

Total_Value Decimal

Payment_Terms_In_Days Integer

Sales_Tax_Value Decimal

Omit_Header Boolean

Always_Show_Bic_And_Iban Boolean

Send_Reminder_Emails Boolean

Updated_At Timestamp

Send_Thank_You_Emails Boolean

Bank_Account_Id String

Bank_Account String

Invoice_Items Array

Payment_Methods Array

Examples
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SELECT
    *
FROM
    Recurring_Invoice_Invoice_Items
WHERE
    Id = '41506170'
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Sales_Tax_Periods table

Column Type

Id Integer

Url URI

Locked_Reason String

Is_Locked Boolean

Effective_Date String

Sales_Tax_Name String

Sales_Tax_Rate_1 Decimal

Sales_Tax_Rate_2 Decimal

Sales_Tax_Rate_3 Decimal

Sales_Tax_Registration_Number String

Sales_Tax_Is_Value_Added Boolean

Sales_Tax_Registration_Status String

Second_Sales_Tax_Name String

Second_Sales_Tax_Is_Compound Boolean

Second_Sales_Tax_Rate_1 Decimal

Second_Sales_Tax_Rate_2 Decimal

Second_Sales_Tax_Rate_3 Decimal

Examples

SELECT
    *
FROM
    Sales_Tax_Periods
WHERE
    Is_Locked = FALSE

INSERT INTO
    Sales_Tax_Periods (
        Sales_Tax_Name,
        Sales_Tax_Rate_1,
        Sales_Tax_Is_Value_Added,
        Sales_Tax_Registration_Status,
        Effective_Date
    )
VALUES
    (
        'VAT Reduced',
        '15',
        'true',
        '1234567890',
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        '2026-01-01'
    )

UPDATE Sales_Tax_Periods
SET
    Sales_Tax_Rate_1 = '16'
WHERE
    Id = '75824'

DELETE FROM Sales_Tax_Periods
WHERE
    Id = '75822'
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Tasks table

Column Type

Id Integer

Url URI

Updated_At Timestamp

Project String

Name String

Currency String

Is_Billable Boolean

Status String

Billing_Rate Decimal

Billing_Period String

Created_At Timestamp

Is_Deletable Boolean

Examples

SELECT
    *
FROM
    Tasks
WHERE
    Is_Deletable = False

INSERT INTO
    Tasks (
        [Name],
        Currency,
        Is_Billable,
        Billing_Period,
        Billing_Rate,
        Project,
        [Status],
        Is_Deletable
    )
VALUES
    (
        'Test task.',
        'GBP',
        'true',
        'hour',
        '249.95',
        'https://api.freeagent.com/v2/projects/4088689',
        'Active',
        'true'
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    )

UPDATE TASKS
SET
    Name = 'Test task 2.'
WHERE
    Id = '5399215'

DELETE FROM Tasks
WHERE
    Id = '5399215'
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Timeslips table

Column Type

Id Integer

Url URI

From_Date Parameter

To_Date Parameter

Updated_Since Parameter

Created_At Timestamp

User_Id String

User URI

Project_Id String

Project URI

Task URI

Hours Decimal

Dated_On String

Updated_At Timestamp

Comment String

Examples

SELECT
    *
FROM
    Timeslips
WHERE
    Hours >= 6

INSERT INTO
    Timeslips (User, Project, Task, Dated_On, [Hours])
VALUES
    (
        'https://api.freeagent.com/v2/users/1853395',
        'https://api.freeagent.com/v2/projects/4088689',
        'https://api.freeagent.com/v2/tasks/5394290',
        '2024-12-03',
        '6'
    )

UPDATE Timeslips
SET
    Hours = 10
WHERE
    Id = '48653687'
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DELETE FROM Timeslips
WHERE
    Id = '48653687'
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Users table

Column Type

Id Integer

Url URI

First_Name String

Role String

Last_Name String

Created_At Timestamp

Hidden Boolean

Email String

Opening_Mileage Decimal

Permission_Level Integer

Updated_At Timestamp

Send_Invitation Boolean

Examples

SELECT
    *
FROM
    Users
WHERE
    Permission_Level = 8

INSERT INTO
    Users (
        First_Name,
        Last_Name,
        Email,
        Role,
        Permission_Level
    )
VALUES
    (
        'Thomas',
        'Axen',
        'ta@example.com',
        'Employee',
        '8'
    )

UPDATE Users
SET
    Last_Name = 'Jones'
WHERE
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    Id = '1853395'

DELETE FROM Users
WHERE
    Id = '1853395'
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API view

Column Type

URL String

Method String

Code Integer

Accept String

RequestType String

RequestBody String

ResponseType String

ResponseBody String

Examples

SELECT
    *
FROM
    API
WHERE
    Url = '/v2/expenses/mileage_settings'
    AND Method = 'GET'

SELECT
    *
FROM
    API
WHERE
    Url = '/v2/capital_assets?include_history=true'
    AND Method = 'GET'

-- Change the status of an invoice.
SELECT
    *
FROM
    API
WHERE
    Url = '/v2/invoices/INVOICEID/transitions/MARKAS'
    AND Method = 'PUT'

-- Retrieve, update, and remove the additional text for an invoice.
SELECT
    *
FROM
    API
WHERE
    Url = '/v2/invoices/default_additional_text'
    AND Method = 'GET'
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SELECT
    *
FROM
    API
WHERE
    Url = '/v2/invoices/default_additional_text'
    AND Method = 'PUT'
    AND RequestBody = '{"default_additional_text":"Please pay promptly."}'

SELECT
    *
FROM
    API
WHERE
    Url = '/v2/invoices/default_additional_text'
    AND Method = 'DELETE'

-- Retrieve journal lines.
SELECT * FROM Journal_Sets_Journal_Entries WHERE Id='5754992'
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Balance_Sheet view

Column Type

Accounting_Period_Start_Date String

As_At_Date String

Currency String

Capital_Assets_Net_Book_Value Integer

Capital_Assets_Accounts Array

Current_Liabilities_Accounts Array

Current_Assets_Accounts Array

Total_Assets Integer

Net_Current_Assets Integer

Owners_Equity_Retained_Profit Integer

Owners_Equity_Accounts Array

Total_Owners_Equity Integer
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Balance_Sheet_Capital_Assets view

Column Type

Accounting_Period_Start_Date String

As_At_Date String

Currency String

Capital_Assets_Net_Book_Value Integer

Total_Assets Integer

Net_Current_Assets Integer

Owners_Equity_Retained_Profit Integer

Total_Owners_Equity Integer

Capital_Assets_Name String

Capital_Assets_Nominal_Code String

Capital_Assets_Total_Debit_Value Decimal
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Balance_Sheet_Current_Assets view

Column Type

Accounting_Period_Start_Date String

As_At_Date String

Currency String

Capital_Assets_Net_Book_Value Integer

Total_Assets Integer

Net_Current_Assets Integer

Owners_Equity_Retained_Profit Integer

Total_Owners_Equity Integer

Current_Assets_Name String

Current_Assets_Nominal_Code String

Current_Assets_Total_Debit_Value Decimal
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Balance_Sheet_Current_Liabilities view

Column Type

Accounting_Period_Start_Date String

As_At_Date String

Currency String

Capital_Assets_Net_Book_Value Integer

Total_Assets Integer

Net_Current_Assets Integer

Owners_Equity_Retained_Profit Integer

Total_Owners_Equity Integer

Current_Liabilities_Name String

Current_Liabilities_Nominal_Code String

Current_Liabilities_Total_Debit_Value Decimal
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Balance_Sheet_Opening_Balances view

Column Type

Currency String

Capital_Assets_Net_Book_Value Integer

Capital_Assets_Accounts Array

Current_Liabilities_Accounts Array

Current_Assets_Accounts Array

Total_Assets Integer

Net_Current_Assets Integer

Owners_Equity_Retained_Profit Integer

Owners_Equity_Accounts Array

Total_Owners_Equity Integer
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Balance_Sheet_Owners_Equity view

Column Type

Accounting_Period_Start_Date String

As_At_Date String

Currency String

Capital_Assets_Net_Book_Value Integer

Total_Assets Integer

Net_Current_Assets Integer

Owners_Equity_Retained_Profit Integer

Total_Owners_Equity Integer

Owners_Equity_Name String

Owners_Equity_Nominal_Code String

Owners_Equity_Total_Debit_Value Decimal

134  



Bank_Accounts_Marked_For_Review_Category_Group_Counts view

Column Type

Id String

Url URI

Type String

View String

Email String

Account_Number String

Current_Balance Decimal

Unexplained_Transaction_Count Integer

Name String

Opening_Balance Decimal

Manually_Added_Transaction_Count Integer

Updated_At Timestamp

Is_Personal Boolean

Total_Count Integer

Is_Primary Boolean

Currency String

Status String

Marked_For_Review_Count Integer

Latest_Activity_Date String

Bank_Code String

Created_At Timestamp

Bank_Feed_Enabled Boolean

Bank_Guess_Enabled Boolean

Bank_Name String

Sort_Code String

Secondary_Sort_Code String

Iban String

Bic String

Default_Property String

Marked_For_Review_Category_Group_Counts_N
ame

String

Marked_For_Review_Category_Group_Counts_N
ominal_Code

String

Marked_For_Review_Category_Group_Counts_C
ount

Integer
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Column Type

Marked_For_Review_Category_Group_Counts_Si
gn

Integer
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Bank_Transactions view

Column Type

Id String

Url URI

Bank_Account_Id String

Bank_Account String

Transaction_Type String

View String

From_Date Parameter

To_Date Parameter

Updated_Since Parameter

Amount Decimal

Dated_On String

Is_Manual Boolean

Matching_Transactions_Count Integer

Description String

Full_Description String

Unexplained_Amount Decimal

Created_At Timestamp

Updated_At Timestamp

Transaction_Id String

Uploaded_At Timestamp

Bank_Transaction_Explanations Array
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Bank_Transactions_Explanations view

Column Type

Id String

Url URI

Bank_Account_Id String

Bank_Account String

View String

From_Date Parameter

To_Date Parameter

Updated_Since Parameter

Amount Decimal

Dated_On String

Is_Manual Boolean

Matching_Transactions_Count Integer

Description String

Full_Description String

Unexplained_Amount Decimal

Created_At Timestamp

Updated_At Timestamp

Transaction_Id String

Uploaded_At Timestamp

Bank_Transaction_Explanations_Dated_On String

Bank_Transaction_Explanations_Bank_Account String

Bank_Transaction_Explanations_Transaction_D
escription

String

Bank_Transaction_Explanations_Is_Money_Out Boolean

Bank_Transaction_Explanations_Is_Deletable Boolean

Bank_Transaction_Explanations_Transfer_Value Decimal

Bank_Transaction_Explanations_Gross_Value Decimal

Bank_Transaction_Explanations_Category String

Bank_Transaction_Explanations_Url URI

Bank_Transaction_Explanations_Description String

Bank_Transaction_Explanations_Is_Locked Boolean

Bank_Transaction_Explanations_Foreign_Curren
cy_Value

Decimal

Bank_Transaction_Explanations_Type String
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Column Type

Bank_Transaction_Explanations_Has_Pending_
Operation

Boolean

Bank_Transaction_Explanations_Is_Money_In Boolean

Bank_Transaction_Explanations_Sales_Tax_Val
ue

Decimal

Bank_Transaction_Explanations_Is_Money_Paid
_To_User

Boolean

Bank_Transaction_Explanations_Guess_Rule_N
ame

String

Bank_Transaction_Explanations_Guessed_Cate
gory

String

Bank_Transaction_Explanations_Bank_Transact
ion

String

Bank_Transaction_Explanations_Marked_For_R
eview

Boolean

Bank_Transaction_Explanations_Updated_At Timestamp

Bank_Transaction_Explanations_Detail String

Bank_Transaction_Explanations_Sales_Tax_Stat
us

String

Bank_Transaction_Explanations_Sales_Tax_Rat
e

Decimal

Bank_Transaction_Explanations_Paid_Invoice String
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Bill_Items view

Column Type

Id String

Url URI

Total_Value Decimal

Status String

Paid_Value Decimal

Contact String

Project String

Created_At Timestamp

Updated_At Timestamp

Dated_On String

Reference String

Native_Due_Value Decimal

Due_On String

Net_Value Decimal

Paid_On String

Long_Status String

Due_Value Decimal

Currency String

Input_Total_Values_Inc_Tax Boolean

Sales_Tax_Value Decimal

Is_Paid_By_Hire_Purchase Boolean

Locked_Reason String

Contact_Name String

Comments String

Second_Sales_Tax_Value Decimal

Recurring String

View String

From_Date Parameter

To_Date Parameter

Updated_Since Parameter

Bill_Items_Url URI

Bill_Items_Sales_Tax_Rate Decimal

Bill_Items_Locked_Attributes Array

Bill_Items_Bill String
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Column Type

Bill_Items_Total_Value_Ex_Tax String

Bill_Items_Category String

Bill_Items_Total_Value String

Bill_Items_Sales_Tax_Status String

Bill_Items_Locked_Reason String

Bill_Items_Sales_Tax_Value Decimal
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Capital_Assets table

Column Type

Id String

Url URI

View String

Created_At Timestamp

Description String

Asset_Type String

Asset_Life_Years Integer

Purchased_On String

Updated_At Timestamp

Depreciation_Profile_Method String

Depreciation_Profile_Asset_Life_Years Integer

Depreciation_Profile_Frequency String

Examples

SELECT
    TIMESTAMPADD (SQL_TSI_YEAR, Asset_Life_Years, Created_At) as EndOfDep,
    ca.*
FROM
    Capital_Assets ca
WHERE
    TIMESTAMPADD (SQL_TSI_YEAR, Asset_Life_Years, Created_At) > Current_Timestamp
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Capital_Assets_History view

Column Type

Id String

Url URI

View String

Created_At Timestamp

Description String

Asset_Type String

Asset_Life_Years Integer

Purchased_On String

Updated_At Timestamp

Depreciation_Profile_Method String

Depreciation_Profile_Asset_Life_Years Integer

Depreciation_Profile_Frequency String

Capital_Asset_History_Type String

Capital_Asset_History_Description String

Capital_Asset_History_Date String

Capital_Asset_History_Value Decimal

Capital_Asset_History_Tax_Value Decimal

Capital_Asset_History_Link_Id String

Capital_Asset_History_Link String
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Cashflow view

Column Type

From_Date Parameter

To_Date Parameter

Outgoing_Months Object

Outgoing_Total String

From String

Balance String

Incoming_Months Object

Incoming_Total String

To String
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Cashflow_Incoming view

Column Type

From_Date Parameter

To_Date Parameter

Outgoing_Months Object

Outgoing_Total String

From String

Balance String

Incoming_Total String

To String

Incoming_Months_Month Integer

Incoming_Months_Year Integer

Incoming_Months_Total String
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Cashflow_Outgoing view

Column Type

From_Date Parameter

To_Date Parameter

Outgoing_Total String

From String

Balance String

Incoming_Months Object

Incoming_Total String

To String

Outgoing_Months_Month Integer

Outgoing_Months_Year Integer

Outgoing_Months_Total String
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Cis_Bands view

Column Type

Name String

Deduction_Rate Decimal

Income_Description String

Deduction_Description String

Nominal_Code String
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Company view

Column Type

Id String

Name String

Type String

Country String

Url URI

Mileage_Units String

Company_Start_Date String

Locale String

Subdomain String

Currency String

Short_Date_Format String

Freeagent_Start_Date String

Town String

First_Accounting_Year_End String

Company_Registration_Number String

Address1 String

Address2 String

Address3 String

Updated_At String

Sales_Tax_Name String

Region String

Postcode String

Supports_Auto_Sales_Tax_On_Purchases Boolean

Business_Category String

Cis_Enabled Boolean

Created_At String

Sales_Tax_Registration_Status String

Ec_Vat_Reporting_Enabled Boolean

Sales_Tax_Effective_Date String

Initially_On_Frs Boolean

Sales_Tax_Is_Value_Added Boolean

Initial_Vat_Basis String

Second_Sales_Tax_Name String

Time_Zone String
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Column Type

Second_Sales_Tax_Is_Compound Boolean

Sales_Tax_Registration_Number String

Vat_First_Return_Period_Ends_On String

Contact_Email String

Business_Type String

Website String

Logo_Url URI

Logo_File_Name String

Logo_Content_Type String

Logo_Content_Src String

Logo_Content_Src_Medium String

Logo_Content_Src_Small String

Logo_Expires_At String

Locked_Attributes Array

Annual_Accounting_Periods Array

Sales_Tax_Rates Array

Second_Sales_Tax_Rates Array
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Company_Annual_Accounting_Periods view

Column Type

Id String

Name String

Type String

Country String

Url URI

Mileage_Units String

Company_Start_Date String

Locale String

Subdomain String

Currency String

Short_Date_Format String

Freeagent_Start_Date String

Town String

First_Accounting_Year_End String

Company_Registration_Number String

Address1 String

Address2 String

Address3 String

Updated_At String

Sales_Tax_Name String

Region String

Postcode String

Supports_Auto_Sales_Tax_On_Purchases Boolean

Business_Category String

Cis_Enabled Boolean

Created_At String

Sales_Tax_Registration_Status String

Ec_Vat_Reporting_Enabled Boolean

Sales_Tax_Effective_Date String

Initially_On_Frs Boolean

Sales_Tax_Is_Value_Added Boolean

Initial_Vat_Basis String

Second_Sales_Tax_Name String

Time_Zone String

150  



Column Type

Second_Sales_Tax_Is_Compound Boolean

Sales_Tax_Registration_Number String

Vat_First_Return_Period_Ends_On String

Contact_Email String

Business_Type String

Website String

Logo_Url URI

Logo_File_Name String

Logo_Content_Type String

Logo_Content_Src String

Logo_Content_Src_Medium String

Logo_Content_Src_Small String

Logo_Expires_At String

Annual_Accounting_Periods_Starts_On String

Annual_Accounting_Periods_Ends_On String
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Company_Business_Categories view

Column Type

Business_Category String
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Company_Locked_Attributes view

Column Type

Id Integer

Name String

Type String

Country String

Url URI

Mileage_Units String

Company_Start_Date String

Locale String

Subdomain String

Currency String

Short_Date_Format String

Freeagent_Start_Date String

Town String

First_Accounting_Year_End String

Company_Registration_Number String

Address1 String

Address2 String

Address3 String

Updated_At String

Sales_Tax_Name String

Region String

Postcode String

Supports_Auto_Sales_Tax_On_Purchases Boolean

Business_Category String

Cis_Enabled Boolean

Created_At String

Sales_Tax_Registration_Status String

Ec_Vat_Reporting_Enabled Boolean

Sales_Tax_Effective_Date String

Initially_On_Frs Boolean

Sales_Tax_Is_Value_Added Boolean

Initial_Vat_Basis String

Second_Sales_Tax_Name String

Time_Zone String
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Column Type

Second_Sales_Tax_Is_Compound Boolean

Sales_Tax_Registration_Number String

Vat_First_Return_Period_Ends_On String

Contact_Email String

Business_Type String

Website String

Logo_Url URI

Logo_File_Name String

Logo_Content_Type String

Logo_Content_Src String

Logo_Content_Src_Medium String

Logo_Content_Src_Small String

Logo_Expires_At String

Locked_Attributes_Array_Id String
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Company_Sales_Tax_Rates view

Column Type

Id String

Name String

Type String

Country String

Url URI

Mileage_Units String

Company_Start_Date String

Locale String

Subdomain String

Currency String

Short_Date_Format String

Freeagent_Start_Date String

Town String

First_Accounting_Year_End String

Company_Registration_Number String

Address1 String

Address2 String

Address3 String

Updated_At String

Sales_Tax_Name String

Region String

Postcode String

Supports_Auto_Sales_Tax_On_Purchases Boolean

Business_Category String

Cis_Enabled Boolean

Created_At String

Sales_Tax_Registration_Status String

Ec_Vat_Reporting_Enabled Boolean

Sales_Tax_Effective_Date String

Initially_On_Frs Boolean

Sales_Tax_Is_Value_Added Boolean

Initial_Vat_Basis String

Second_Sales_Tax_Name String

Time_Zone String
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Column Type

Second_Sales_Tax_Is_Compound Boolean

Sales_Tax_Registration_Number String

Vat_First_Return_Period_Ends_On String

Contact_Email String

Business_Type String

Website String

Logo_Url URI

Logo_File_Name String

Logo_Content_Type String

Logo_Content_Src String

Logo_Content_Src_Medium String

Logo_Content_Src_Small String

Logo_Expires_At String

Sales_Tax_Rates_Array_Id String
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Company_Tax_Timeline view

Column Type

Description String

Nature String

Dated_On String

Is_Personal Boolean

Amount_Due real

Status String
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Corporation_Tax_Returns view

Column Type

Id String

Url URI

Filing_Status String

Period_Ends_On String

Period_Starts_On String

Filing_Due_On String

Payment_Due_On String

Amount_Due String

Payment_Status String
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Credit_Note_Items view

Column Type

Id Integer

Url URI

Contact_Id String

Contact String

Due_Value Decimal

Updated_At Timestamp

Payment_Terms_In_Days Integer

Due_On String

Omit_Header Boolean

Dated_On String

Reference String

Status String

Currency String

Total_Value Decimal

Involves_Sales_Tax Boolean

Exchange_Rate Decimal

Net_Value Decimal

Is_Interim_Uk_Vat Boolean

Refunded_Value Decimal

Long_Status String

Created_At Timestamp

Bank_Account_Id String

Bank_Account String

Contact_Name String

Sales_Tax_Value Decimal

Refunded_On String

Comments String

Second_Sales_Tax_Value Decimal

Credit_Note_Items_Url_Id URI

Credit_Note_Items_Url URI

Credit_Note_Items_Quantity Decimal

Credit_Note_Items_Position Integer

Credit_Note_Items_Description String

Credit_Note_Items_Suffers_Cis_Deduction Boolean
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Column Type

Credit_Note_Items_Item_Type String

Credit_Note_Items_Price Decimal

Credit_Note_Items_Sales_Tax_Rate Decimal

Credit_Note_Items_Sales_Tax_Status String

Credit_Note_Items_Second_Sales_Tax_Rate Decimal

Credit_Note_Items_Second_Sales_Tax_Status String

Credit_Note_Items_Category_Id String

Credit_Note_Items_Category String
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Email_Addresses view

Column Type

Email_Address String
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Invoice_Items view

Column Type

Id String

Url URI

Exchange_Rate Decimal

Contact_Id String

Contact String

Total_Value Decimal

Omit_Header Boolean

Updated_At Timestamp

Dated_On String

Currency String

Due_On String

Refunded_Value String

Contact_Name String

Is_Interim_Uk_Vat Boolean

Reference String

Net_Value Decimal

Involves_Sales_Tax Boolean

Payment_Terms_In_Days Integer

Due_Value Decimal

Status String

Long_Status String

Created_At Timestamp

Bank_Account_Id String

Bank_Account String

Paid_Value Decimal

Always_Show_Bic_And_Iban Boolean

Paid_On String

Payment_Methods_Paypal Boolean

Payment_Methods_Stripe Boolean

Send_Reminder_Emails Boolean

Send_New_Invoice_Emails Boolean

Send_Thank_You_Emails Boolean

Sales_Tax_Value Decimal

Second_Sales_Tax_Value Decimal
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Column Type

Client_Contact_Name String

Project String

Po_Reference String

Discount_Percent Decimal

Discount_Value Decimal

Comments String

Show_Project_Name Boolean

Written_Off_Date String

Include_Timeslips String

Include_Expenses String

Include_Estimates String

Recurring_Invoice String

Invoice_Items_Url_Id URI

Invoice_Items_Url URI

Invoice_Items_Project_Id String

Invoice_Items_Project String

Invoice_Items_Position Integer

Invoice_Items_Quantity Decimal

Invoice_Items_Second_Sales_Tax_Rate Decimal

Invoice_Items_Description String

Invoice_Items_Price Decimal

Invoice_Items_Category_Id String

Invoice_Items_Category String

Invoice_Items_Item_Type String

Invoice_Items_Sales_Tax_Rate Decimal

Invoice_Items_Suffers_Cis_Deduction Boolean

Invoice_Items_Sales_Tax_Status String

Invoice_Items_Second_Sales_Tax_Status String

Invoice_Items_Stock_Item_Id String

Invoice_Items_Stock_Item String
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Journal_Sets_Bank_Accounts view

Column Type

Id Integer

Url URI

From_Date Parameter

To_Date Parameter

Updated_Since Parameter

Tag Parameter

Updated_At Timestamp

Dated_On String

Description String

Bank_Accounts_Url_Id URI

Bank_Accounts_Url URI

Bank_Accounts_Description String

Bank_Accounts_Debit_Value Decimal
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Journal_Sets_Journal_Entries view

Column Type

Id Integer

Url URI

From_Date Parameter

To_Date Parameter

Updated_Since Parameter

Tag Parameter

Updated_At Timestamp

Dated_On String

Description String

Journal_Entries_Url_Id URI

Journal_Entries_Url URI

Journal_Entries_Description String

Journal_Entries_Category_Id Integer

Journal_Entries_Category String

Journal_Entries_Debit_Value Decimal

Examples

SELECT
    *
FROM
    Journal_Sets_Journal_Entries
WHERE
    Id = '5754992'
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Journal_Sets_Stock_Items view

Column Type

Id Integer

Url URI

From_Date Parameter

To_Date Parameter

Updated_Since Parameter

Tag Parameter

Updated_At Timestamp

Dated_On String

Description String

Stock_Items_Url_Id URI

Stock_Items_Url URI

Stock_Items_Description String

Stock_Items_Debit_Value Decimal

166  



Opening_Balance_Summary view

Column Type

Id Integer

Category String

Display_Nominal_Code String

Nominal_Code String

From_Date Parameter

To_Date Parameter

User String

Name String

Total Decimal

Bank_Account_Id String

Bank_Account String
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Payroll_Payslips view

Column Type

User_Id String

User URI

Year Integer

Period Integer

Postgrad_Loan_Deduction Decimal

Employer_Ni Decimal

Student_Loan_Deduction Decimal

Employee_Pension_Salary_Sacrifice Decimal

Tax_Code String

Other_Deductions Decimal

Commission Decimal

Frequency String

Other_Deductions_From_Net_Pay Decimal

Absence_Payments Decimal

Statutory_Adoption_Pay Decimal

Dated_On Date

Deduction_Free_Pay Decimal

Basic_Pay Decimal

Week_1_Month_1_Basis Boolean

Tax_Deducted Decimal

Statutory_Maternity_Pay Decimal

Statutory_Sick_Pay Decimal

Statutory_Paternity_Pay Decimal

Employee_Ni Decimal

Employer_Pension Decimal

Overtime Decimal

Allowance Decimal

Bonus Decimal

Statutory_Parental_Bereavement_Pay Decimal

Other_Payments Decimal

Created_At Timestamp

Employee_Pension Decimal

Employee_Pension_Not_Under_Net_Pay Decimal

Attachments Decimal
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Column Type

Payroll_Giving Decimal

Ni_Calc_Type String

Additional_Statutory_Paternity_Pay Decimal

Deductions_Subject_To_Nic_But_Not_Paye Decimal

Other_Salary_Sacrifice_Deductions Decimal

Ni_Letter String

Deduct_Student_Loan Boolean

Deduct_Postgrad_Loan Boolean

Student_Loan_Deductions_Plan String

Hours_Worked Decimal

Updated_At Timestamp

Period_Url_Id URI

Period_Url URI

Period_Status String

Period_Updated_At Timestamp

Period_Dated_On String

Period_Employment_Allowance_Claimed Boolean

Period_Created_At Timestamp

Period_Employment_Allowance_Amount Decimal

Period_Construction_Industry_Scheme_Deducti
on

Decimal

Period_Frequency String
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Payroll_Periods view

Column Type

Year Integer

Period Integer

Url URI

Employment_Allowance_Amount String

Frequency String

Status String

Dated_On String

Employment_Allowance_Claimed Boolean

Construction_Industry_Scheme_Deduction String

Created_At Timestamp

Updated_At Timestamp
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Payroll_Profiles view

Column Type

Year Integer

User String

Address_Line_1 String

Address_Line_3 String

Address_Line_2 String

Postcode String

Total_Pay_In_Previous_Employment Decimal

Title String

Gender String

Date_Of_Birth String

Total_Tax_In_Previous_Employment Decimal

Created_At Datetime

Updated_At Datetime

  171



Profit_And_Loss view

Column Type

From_Date Parameter

To_Date Parameter

Accounting_Period Parameter

From String

To String

Operating_Profit Decimal

Retained_Profit Decimal

Expenses Decimal

Retained_Profit_Brought_Forward Decimal

Income Decimal

Retained_Profit_Carried_Forward Decimal

Less Array
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Profit_And_Loss_Less view

Column Type

From_Date Parameter

To_Date Parameter

Accounting_Period Parameter

From String

To String

Operating_Profit Decimal

Retained_Profit Decimal

Expenses Decimal

Retained_Profit_Brought_Forward Decimal

Income Decimal

Retained_Profit_Carried_Forward Decimal

Less_Title String

Less_Total Decimal
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Recurring_Invoice_Invoice_Items view

Column Type

Id Integer

Url URI

Net_Value Decimal

Recurring_End_Date String

Next_Recurs_On String

Contact_Id String

Contact String

Send_New_Invoice_Emails Boolean

Comments String

Contact_Name String

Dated_On String

Recurring_Status String

Frequency String

Reference String

Created_At Timestamp

Due_Value Decimal

Profile_Id String

Currency String

Exchange_Rate Decimal

Second_Sales_Tax_Value Decimal

Total_Value Decimal

Payment_Terms_In_Days Integer

Sales_Tax_Value Decimal

Omit_Header Boolean

Always_Show_Bic_And_Iban Boolean

Send_Reminder_Emails Boolean

Updated_At Timestamp

Send_Thank_You_Emails Boolean

Bank_Account_Id String

Bank_Account String

Invoice_Items_Id String

Invoice_Items_Url URI

Invoice_Items_Position Integer

Invoice_Items_Price Decimal
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Column Type

Invoice_Items_Description String

Invoice_Items_Item_Type String

Invoice_Items_Quantity Decimal

Invoice_Items_Stock_Item_Id String

Invoice_Items_Stock_Item String

Invoice_Items_Sales_Tax_Rate Decimal

Invoice_Items_Suffers_Cis_Deduction Boolean

Invoice_Items_Second_Sales_Tax_Rate Decimal

Invoice_Items_Sales_Tax_Status String

Invoice_Items_Second_Sales_Tax_Status String

Invoice_Items_Category_Id String

Invoice_Items_Category String
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Stock_Items view

Column Type

Id Integer

Url URI

Updated_At Timestamp

Description String

Cost_Of_Sale_Category String

Opening_Quantity Decimal

Created_At Timestamp

Opening_Balance Decimal

Stock_On_Hand Decimal
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Transactions view

Column Type

Id Integer

Url URI

From_Date Parameter

To_Date Parameter

Dated_On String

Description String

Debit_Value Decimal

Created_At Timestamp

Updated_At Timestamp

Category String

Category_Name String

Nominal_Code String

Source_Item_Url URI

Foreign_Currency_Data_Currency_Code String

Foreign_Currency_Data_Debit_Value String
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Trial_Balance_Summary view

Column Type

Id Integer

Category String

Display_Nominal_Code String

Nominal_Code String

From_Date Parameter

To_Date Parameter

User String

Name String

Total Decimal

Bank_Account_Id String

Bank_Account String
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Vat_Return_Payments view

Column Type

Year year

Url URI

Filing_Due_On String

Period_Starts_On String

Period_Ends_On String

Filing_Status String

Payments_Amount_Due Integer

Payments_Label String

Payments_Due_On String
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Vat_Returns view

Column Type

Year year

Url URI

Filing_Due_On String

Period_Starts_On String

Period_Ends_On String

Filing_Status String

Payments Array

180  



Index

A
Access

importing FreeAgent data, 39
linking FreeAgent data, 39

API view, 30
authentication, 12

B
Base

working with FreeAgent data, 48

C
Cache Timeout attribute, 15
caching, 15
Client Id attribute, 12, 15
Client Secret attribute, 12, 15
connecting to FreeAgent, 11
connection string attributes, 16

D
data source attributes, 13
data sources

removing
on Windows, 10

data type mapping, 67
deleting records, 28
Description attribute, 13
DG4ODBC

working with FreeAgent data, 44
DSN attribute, 13
DSN-less connections, 16

E
Easysoft ODBC-FreeAgent Driver

adding ODBC data sources
on Windows, 11

authentication and, 12
caching, 15
connecting to FreeAgent, 11
data source attributes, 13
data type mapping, 67
DSN-less connections, 16
FreeAgent data model, 78
installing

on Windows, 8
logging, 35
ODBC API support, 62
scalar function support, 64
SQL support, 68
uninstalling

on Windows, 10
Excel

importing FreeAgent data with Data

Connection Wizard, 40
importing FreeAgent data with PowerPivot,

40
importing FreeAgent data with Query, 40

F
Flush On Update attribute, 14

G
Go

working with FreeAgent data, 49

I
inserting records, 18
installing the Easysoft ODBC-FreeAgent Driver,

7

J
JSON columns, 31

L
LibreOffice

working with FreeAgent data, 48
linked server

working with FreeAgent data, 42
Local Filtering attribute, 13
Log File attribute, 14
log files, 35
Logging attribute, 14

M
Max Num attribute, 14

N
Node.js

working with FreeAgent data, 50

O
OAuth, 12
ODBC API function support, 62
ODBC connection string attributes, 16
ODBC data sources

adding
on Windows, 11

removing
on Windows, 10

Oracle
working with FreeAgent data, 44

P
Perl

working with FreeAgent data, 52
PHP

working with FreeAgent data, 55
Power BI

importing FreeAgent data, 41

  181



PowerPivot
importing FreeAgent data, 40

Proxy attribute, 13
Proxy Password attribute, 13
Proxy User attribute, 13
Python

working with FreeAgent data, 57

R
R

working with FreeAgent data, 59
Refresh Token attribute, 13

S
Sandbox attribute, 14
scalar function support, 64
selecting records, 17
SQL Server

working with FreeAgent data, 42
SQL support, 68

T
tables

Bank_Accounts, 80
Bank_Feeds, 82
Bank_Transaction_Explanations, 83
Bank_Transaction_Explanations_Attachment,

86
Bills, 88
Capital_Asset_Types, 90
Capital_Assets, 142
Categories_Admin_Expenses, 91
Categories_Cost_Of_Sales, 92
Categories_General, 93
Categories_Income, 94
Contacts, 95
Credit_Note_Reconciliations, 97
Credit_Notes, 99
Estimates, 101
Expenses, 103
Final_Accounts_Reports, 105
Hire_Purchases, 106
Invoices, 107
Journal_Sets, 109
Notes, 111
Price_List_Items, 112
Projects, 114
Properties, 116
Recurring_Invoices, 117
Sales_Tax_Periods, 119
Tasks, 121
Timeslips, 123
Users, 125

trace files, 35

U
uninstalling

on Windows, 10
updating records, 25

V
views

API, 127
Balance_Sheet, 129
Balance_Sheet_Capital_Assets, 130
Balance_Sheet_Current_Assets, 131
Balance_Sheet_Current_Liabilities, 132
Balance_Sheet_Opening_Balances, 133
Balance_Sheet_Owners_Equity, 134
Bank_Accounts_Marked_For_Review_Catego

ry_Group_Counts, 135
Bank_Transactions, 137
Bank_Transactions_Explanations, 138
Bill_Items, 140
Capital_Assets_History, 143
Cashflow, 144
Cashflow_Incoming, 145
Cashflow_Outgoing, 146
Cis_Bands, 147
Company, 148
Company_Annual_Accounting_Periods, 150
Company_Business_Categories, 152
Company_Locked_Attributes, 153
Company_Sales_Tax_Rates, 155
Company_Tax_Timeline, 157
Corporation_Tax_Returns, 158
Credit_Note_Items, 159
Email_Addresses, 161
Invoice_Items, 162
Journal_Sets_Bank_Accounts, 164
Journal_Sets_Journal_Entries, 165
Journal_Sets_Stock_Items, 166
Opening_Balance_Summary, 167
Payroll_Payslips, 168
Payroll_Periods, 170
Payroll_Profiles, 171
Profit_And_Loss, 172
Profit_And_Loss_Less, 173
Recurring_Invoice_Invoice_Items, 174
Stock_Items, 176
Transactions, 177
Trial_Balance_Summary, 178
Vat_Return_Payments, 179
Vat_Returns, 180

182  


	Easysoft ODBC-FreeAgent Driver User’s Guide
	Table of contents
	Getting started
	Installing the Easysoft ODBC-FreeAgent Driver
	Installing on Windows
	Uninstalling on Windows

	Connecting to FreeAgent
	Connecting from Windows
	Authentication
	Connection attributes
	DSN-less connections

	Working with FreeAgent data
	SELECT statements
	INSERT statements
	UPDATE statements
	DELETE statements
	API view
	JSON columns

	Logging
	ODBC Driver Manager logging on Windows
	Easysoft ODBC-FreeAgent Driver logging on Windows
	Finding out what product version you have on Windows


	Client applications
	Microsoft Access
	Linking a table
	Importing a table

	Microsoft Excel
	Data Connection Wizard
	Microsoft Query
	PowerPivot

	Microsoft Power BI
	Microsoft SQL Server
	Oracle
	Connecting FreeAgent to Oracle on Windows
	Connecting FreeAgent to Oracle on Linux and UNIX

	LibreOffice
	Go
	Node.js
	Perl
	PHP
	Python
	R

	About the Easysoft ODBC-FreeAgent Driver
	ODBC API and scalar functions
	API functions
	Scalar functions

	Data type mapping
	Finding out more about data types on Windows

	SQL support
	Example queries
	Example inserts, updates, and deletes


	Tables
	Bank_Accounts table
	Examples

	Bank_Feeds table
	Examples

	Bank_Transaction_Explanations table
	Examples

	Bank_Transaction_Explanations_Attachment table
	Bills table
	Examples

	Capital_Asset_Types table
	Examples

	Categories_Admin_Expenses table
	Examples

	Categories_Cost_Of_Sales table
	Examples

	Categories_General table
	Examples

	Categories_Income table
	Examples

	Contacts table
	Examples

	Credit_Note_Reconciliations table
	Examples

	Credit_Notes table
	Examples

	Estimates table
	Examples

	Expenses table
	Examples

	Final_Accounts_Reports table
	Examples

	Hire_Purchases table
	Examples

	Invoices table
	Examples

	Journal_Sets table
	Examples

	Notes table
	Examples

	Price_List_Items table
	Examples

	Projects table
	Examples

	Properties table
	Examples

	Recurring_Invoices table
	Examples

	Sales_Tax_Periods table
	Examples

	Tasks table
	Examples

	Timeslips table
	Examples

	Users table
	Examples

	API view
	Examples

	Balance_Sheet view
	Balance_Sheet_Capital_Assets view
	Balance_Sheet_Current_Assets view
	Balance_Sheet_Current_Liabilities view
	Balance_Sheet_Opening_Balances view
	Balance_Sheet_Owners_Equity view
	Bank_Accounts_Marked_For_Review_Category_Group_Counts view
	Bank_Transactions view
	Bank_Transactions_Explanations view
	Bill_Items view
	Capital_Assets table
	Examples

	Capital_Assets_History view
	Cashflow view
	Cashflow_Incoming view
	Cashflow_Outgoing view
	Cis_Bands view
	Company view
	Company_Annual_Accounting_Periods view
	Company_Business_Categories view
	Company_Locked_Attributes view
	Company_Sales_Tax_Rates view
	Company_Tax_Timeline view
	Corporation_Tax_Returns view
	Credit_Note_Items view
	Email_Addresses view
	Invoice_Items view
	Journal_Sets_Bank_Accounts view
	Journal_Sets_Journal_Entries view
	Examples

	Journal_Sets_Stock_Items view
	Opening_Balance_Summary view
	Payroll_Payslips view
	Payroll_Periods view
	Payroll_Profiles view
	Profit_And_Loss view
	Profit_And_Loss_Less view
	Recurring_Invoice_Invoice_Items view
	Stock_Items view
	Transactions view
	Trial_Balance_Summary view
	Vat_Return_Payments view
	Vat_Returns view

	Index

